VoiceOver Getting Started
Includes instructions and command lists for using VoiceOver with Mac OS X version 10.6 Snow Leopard.

Table of Contents
Chapter 1. Introducing VoiceOver
Chapter 2. Learning VoiceOver Basics
Chapter 3. Learning Mac OS X Basics
Chapter 4. Working with Text
Chapter 5. Navigating Content
Chapter 6. Browsing the Internet
Chapter 7. Using Mac OS X Applications
Chapter 8. Collaborating with Other Users
Chapter 9. Customizing VoiceOver
Chapter 10. Using Braille Displays
Chapter 11. Using VoiceOver Gestures
Appendix A. Commands and Gestures
Appendix B. VoiceOver Utility Options
Copyright Notice

Chapter 1. Introducing VoiceOver
This chapter introduces VoiceOver, the advanced screen-reading technology integrated into the Mac OS X operating system. VoiceOver enables users with visual disabilities to control their computer using a rich set of keyboard commands and gestures. This chapter provides an overview of VoiceOver and key topics such as the VoiceOver cursor and current focus, keyboard shortcuts, and using function keys on some keyboards.
About VoiceOver
VoiceOver is a built-in screen reader that describes aloud what appears on your computer screen: it speaks the text that's in documents and windows. To turn on VoiceOver, press Command-F5.

When a supported refreshable braille display is connected to your computer, VoiceOver detects the display and sends it information about what's on the screen using contracted or uncontracted braille. If you're using a Multi-Touch trackpad, you can use VoiceOver gestures to navigate and interact with what's on the screen. Using VoiceOver, you control the computer primarily with a keyboard, braille display, or trackpad, instead of the mouse.

When VoiceOver is on, you can use VoiceOver commands to navigate and interact with items on the screen. You enter VoiceOver commands by holding down the Control and Option keys together, along with one or more other keys. The Control and Option keys are called the "VoiceOver keys," or "VO keys" for short. They are shown in commands as VO, as in VO-F1. You can assign VoiceOver commands to numeric keypad keys, keyboard keys, braille display input keys, and trackpad gestures, so you can use the commands with fewer keystrokes.

You use the VoiceOver cursor to move around the screen and hear descriptions of the items in the cursor. You use it to select buttons and other controls, and to read and edit text. The keyboard focus and mouse pointer work with the VoiceOver cursor in a variety of ways. You can configure them to follow each other, or use them separately to move in different applications at the same time.

The first time you start VoiceOver, you can choose to take the Quick Start tutorial, an interactive tour of VoiceOver navigation and interaction basics. When VoiceOver is on, you can start the tutorial at any time by pressing VO-Command-F8.

You can customize VoiceOver to best suit your needs using VoiceOver Utility.

About the VoiceOver cursor, mouse pointer, and keyboard focus
When you use VoiceOver to move to areas of the screen or within the text in a document, a dark rectangle is drawn around the area where VoiceOver is focused. This rectangle is called the "VoiceOver cursor."

By default, the keyboard focus and VoiceOver cursor match, so that wherever you move the keyboard focus using standard keyboard navigation (Tab key and arrow keys), the VoiceOver cursor follows. And wherever the VoiceOver cursor goes, the keyboard focus follows (if possible). This is called "cursor tracking." You can also turn on cursor tracking for the mouse.
When you open a new window, the VoiceOver cursor and the keyboard focus are positioned on the same item. For example, when you open a New Message window in Mail, the VoiceOver cursor and the keyboard focus are positioned on the To field. If you prefer, you can make the initial position of the VoiceOver cursor be on the first item in the window.

You can turn off cursor tracking. For example, you might want to leave the keyboard focus in one place and move the VoiceOver cursor around to read a dialog that just appeared, check email messages, or perform other tasks. If you turn off cursor tracking, you can use VoiceOver commands to move the VoiceOver cursor to where the keyboard is focused when you need to. You can do the same for the mouse.

You set preferences for the initial position of the cursor and for cursor tracking using VoiceOver Utility.

About keyboard shortcuts and VoiceOver
Applications use key combinations as shortcuts to help you work faster. Many shortcuts are common to all Mac OS X applications, such as Command-S for Save and Command-P for Print. You can use these keyboard shortcuts and VoiceOver commands to control actions on your computer. VoiceOver commands always include the VO keys (the Control and Option keys).

When you use VoiceOver to navigate menus, you hear the keyboard shortcut, if there is one, after the name of the menu command. For example, in the File menu, "New, Command N" means that you can use the keyboard shortcut Command-N to create a new file.

Using function keys on some keyboards
Function keys are located above the number keys at the top of the keyboard. On some keyboards, many of the function keys are programmed to perform hardware-related actions such as adjusting volume, muting sound, and controlling display brightness. If your keyboard has an Fn (function) key, you must press the Fn key and the function key together to use the function key for other actions.

If you use VoiceOver all the time or very frequently, you can change the default behavior of the function keys to perform software actions. Then you have to press the Fn key only to change the volume or change other hardware settings.

To change the default behavior of function keys:

1. Choose Apple menu > System Preferences, click Keyboard, and then Keyboard.

2. Select the "Use all F1, F2, etc. keys as standard function keys" checkbox.
Now you don't need to press the Fn key to use VoiceOver commands; you press it only when you want to use the hardware action of a function key.

The command to turn VoiceOver on and off is Command-F5. You don't need to use the Fn key with this command.

Some keyboards have dedicated keys for Home, End, Page Up, and Page Down. These are important VoiceOver navigation keys. If you’re using a keyboard that doesn’t have these keys, use the arrow keys with the Fn key for these actions.

Chapter 2. Learning VoiceOver Basics
This chapter provides information about the basics of using VoiceOver, including how to get help while you’re learning. You’ll learn how to turn VoiceOver on and off and pause it, how to hear information about items on the screen and interact with them, and how to use cursor tracking.

Turning VoiceOver on and off
You can turn VoiceOver on and off at any time; you don’t have to restart your computer or log in again.

Here are ways to turn VoiceOver on or off:

- Press Command-F5. If VoiceOver is on, pressing Command-F5 turns it off.
- Use the Universal Access pane of System Preferences.

If you set the Universal Access preference to include a Universal Access menu in the status bar, the menu shows when VoiceOver is on or off.

The first time you start VoiceOver, you can choose to take the Quick Start tutorial, an interactive tour of VoiceOver navigation and interaction basics. When VoiceOver is on, you can start the tutorial at any time by pressing VO-Command-F8.

Turning on VoiceOver for the login window
You can select an option in System Preferences to automatically turn on VoiceOver in the Mac OS X login window.
To turn on VoiceOver for the login window:

1. Choose Apple menu > System Preferences and click Accounts.

If Accounts preferences are locked, click the lock icon in the lower-left corner of the page and type an administrator password to unlock them.

2. In the account list, move the VoiceOver cursor to Login Options and press VO-Space bar.

3. In the login options, press VO-Right Arrow until you hear "Use VoiceOver at login window."

4. Press VO-Space bar to select the checkbox.

Pausing speech
When VoiceOver is speaking, you can temporarily pause the speech, and then resume where the speaking left off.

To pause and resume speech:

Press the Control key. If you're using VoiceOver gestures, two-finger tap the trackpad.

To resume speaking, repeat the key or gesture.

If you move the VoiceOver cursor after you pause the speech, VoiceOver begins speaking the item that's now in the VoiceOver cursor.

If you missed what VoiceOver spoke, you can press VO-Z to repeat the last word or phrase.

Using the welcome dialog
When you first start VoiceOver, a welcome dialog is displayed.

Here are ways to use the dialog:

• To continue using VoiceOver, press Enter or click OK.

• To continue using VoiceOver and prevent the welcome dialog from appearing each time VoiceOver starts, press V or click the "Do not show this message again" checkbox.

• To start the VoiceOver Quick Start tutorial, press the Space bar or click Learn VoiceOver.

• To turn off VoiceOver, press Command-Q, press Escape, or click Cancel.

If you chose to not display the welcome dialog again, but you change your mind and want it to be displayed, select the checkbox in the General category of VoiceOver Utility.
Using the VoiceOver Help menu

When VoiceOver is running, you can open the VoiceOver Help menu to learn more about using VoiceOver and to access commands for the item in the VoiceOver cursor.

To use the VoiceOver menu:

1. Open the VoiceOver Help menu by pressing VO-H.

The VoiceOver menu appears on the screen for the benefit of sighted users. To increase or decrease the menu's font size, press the } or { key.

2. Navigate the menu and submenus using the arrow keys.

   • If you know the name of a menu item, type some letters of its name to narrow the menu to only items that contain those letters. To list all the items again, press the Delete key.

   • You hear the number of items a submenu contains when you enter the submenu.

   • If a menu item has a keyboard command, you hear it announced with the name of the item. Next time, you can use the keyboard command without having to open the VoiceOver Help menu. For example, to directly access the Commands menu, you can press VO-H-H.

3. To select a menu item, press the Space bar or the Return key.

To close the VoiceOver Help menu without making a selection, press the Escape key.

Using the Commands menu

If you know the name of a VoiceOver command you want to use but can't recall the keys to press, you can use the Commands menu to find and select the command, to apply it to the item currently in the VoiceOver cursor.

To find a VoiceOver command:
1. When VoiceOver is on, open the Commands menu by pressing VO-H-H.

2. Type some letters of the command name to narrow the Commands menu to just those commands that contain the letters you typed.

   Use the arrow keys to navigate the Commands menu until you hear the command you want. To list all commands again, press Delete.

3. When you hear the command you want to use, press the Return key or the Space bar to apply the command to the item in the VoiceOver cursor.

**Locking the VO keys**

VoiceOver commands are entered by pressing the Control and Option keys (the VO keys) with function keys, arrow keys, and other keys. For example, to open the VoiceOver Help menu press VO-H.

For convenience, you can lock the VO keys so you don't have to press them while entering commands; all you need to press are the remaining keys for the command. For example, to open the VoiceOver Help menu, press H.

To lock or unlock the VO keys:

Press VO-;.

If you're not familiar with the location of special keys on your keyboard, you can turn on keyboard help in VoiceOver.

Refer to "Chapter 2. Learning VoiceOver Basics: Learning about keys, keyboard shortcuts, and gestures."

**Resolving VoiceOver key command conflicts**

Some applications use the Control and Option keys (the VO keys) together with another key to perform an action. If you're using VoiceOver and want to use the application's command, you can type a command that tells VoiceOver to ignore the next key combination.

To have VoiceOver ignore the next key combination:

1. Press VO-Tab.

2. Type the command for the application.

You can change many keyboard shortcuts for Mac OS X applications and other applications in the Keyboard Shortcuts pane of Keyboard preferences.
Learning about keys, keyboard shortcuts, and gestures

Using keyboard help, you can press any key to hear its name, or type any keyboard shortcut to hear the VoiceOver command it represents. In addition, if you’re using:

- The NumPad Commander or Keyboard Commander, you can learn the commands that have been assigned to keys.
- A refreshable braille display, you can learn the display’s key names and their associated commands.
- VoiceOver gestures, you can use any VoiceOver gesture on the trackpad to learn its name and the VoiceOver command it represents.

While you’re using keyboard help, you can’t use your keyboard, braille display, or trackpad for other tasks.

To start keyboard help:

With VoiceOver on, press VO-K.

To hear the name of a keyboard or braille key:

Press the key. For example, press the D key to hear "d."

To hear the VoiceOver command for a key:

Press Control-Option and the key. For example, press Control-Option-D to hear "Control-Option-D Dock Moves VoiceOver cursor to the Dock."

To hear the name and VoiceOver command for a gesture:

Use the gesture on the trackpad. For example, double-tap to hear "Double-tap Select an item."

To hear alternative functions for a key or gesture:

Some keys and gestures perform alternative functions when you press modifier keys such as Shift, Control, Option, or Command.

For keys, try pressing Control-Option with a modifier key and then press a key to hear what other functions the key may have.

To quit keyboard help:
Press the Escape key, located in the upper-left corner of the keyboard.

If you have trouble using your computer's standard QWERTY keyboard, you can switch the keyboard to Dvorak layout, which optimizes key layout for typing comfort and ease of use.

If you have difficulty pressing more than one key at a time, you can turn on Sticky Keys to help you use a combination of modifier keys as a sequence.

**Learning VoiceOver sound effects**
In addition to the set of sounds used in Mac OS X, VoiceOver uses a variety of unique sound effects to denote events (such as a window opening) and location (such as when you reach a border). You can listen to a description of the sounds to help you learn their meanings.

**To hear sound effects descriptions:**

1. Open the VoiceOver Help menu by pressing VO–H.
2. Navigate down the menu to Sounds Help and then press the Right Arrow key.
3. Use the Down Arrow and Up Arrow keys to navigate the list and hear each sound effect and its description.

To repeat a sound effect and description, press the Space bar.

4. When you're done, press the Escape key to close the VoiceOver menu.

**Hearing hints and information about an item**
VoiceOver provides many ways to learn more about the item in the VoiceOver cursor.

**Here are ways to learn about an item:**

- To hear a description of the item, press VO–F3.

If you're using VoiceOver gestures, tap the trackpad three times. If there is no item in the VoiceOver cursor, VoiceOver plays a sound effect to denote a blank area.

- To hear the item's help tag (sometimes called a "tooltip"), press VO–Shift–H. If an item doesn't have a help tag, VoiceOver plays a tone.

- To hear instructions about using the item, press VO–Shift–N.

If you want to hear instructions automatically without pressing a command, select the option in the Hints pane of the Verbosity category in VoiceOver Utility.
Descriptions, help tags, and instructions are displayed in the caption panel and braille panel, if the panels are open.

A webpage can contain keyboard shortcuts, called “access keys,” to web items such as links or buttons. VoiceOver detects access keys and can describe them if you have selected the option to speak help tags in the Hints pane of the Verbosity category in VoiceOver Utility. For example, when VoiceOver detects an access key on a link, it might say “Access key available: s,” where “s” is the access key. You can then press Control-S to open the link.

Finding out where the focus is located
You can use the F1 through F6 keys with the VO keys (the Control and Option keys) to hear information about items on which the VoiceOver cursor, keyboard, or mouse pointer is focused.

<table>
<thead>
<tr>
<th>Press</th>
<th>To hear</th>
</tr>
</thead>
<tbody>
<tr>
<td>VO-F1</td>
<td>The application summary, describing the application that is currently active and the number of other applications that are running.</td>
</tr>
<tr>
<td>VO-F2</td>
<td>The window summary, describing the active window.</td>
</tr>
<tr>
<td>VO-F3</td>
<td>The item on which the VoiceOver cursor is focused. The description includes the current state of the item, such as whether a checkbox is selected, or the percent value of a slider.</td>
</tr>
<tr>
<td></td>
<td>If you’re using VoiceOver gestures, tap the trackpad three times to hear the item in the VoiceOver cursor. If there is no item, a sound effect indicates a blank area on the screen.</td>
</tr>
<tr>
<td>VO-Command-F3</td>
<td>The size of the item in the VoiceOver cursor.</td>
</tr>
<tr>
<td>VO-Command-F3-F3</td>
<td>The position of the item in the VoiceOver cursor.</td>
</tr>
<tr>
<td>VO-F4</td>
<td>The item on which the keyboard is focused. The description includes the current state of the item.</td>
</tr>
<tr>
<td>VO-F4-F4</td>
<td>The location of the insertion point relative to the upper-left corner of the text item in which the insertion point is located. For example, you might hear “Insertion point is two inches right, five inches down from top-left corner of edit text.”</td>
</tr>
<tr>
<td>VO-F5</td>
<td>The item on which the mouse pointer is focused. The description includes the current state of the item.</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VO-F5-F5</td>
<td>The location of the mouse pointer as x and y coordinates on the screen, relative to the upper-left corner of the screen.</td>
</tr>
<tr>
<td>VO-F5-F5-F5</td>
<td>The location of the mouse pointer in x and y coordinates relative to the current window.</td>
</tr>
<tr>
<td>VO-F6</td>
<td>The item that is currently selected (such as a folder or text in a document).</td>
</tr>
</tbody>
</table>

You can also use positional audio to hear sound effects to help locate the VoiceOver cursor on the screen.

Refer to "Chapter 2. Learning VoiceOver Basics: Hearing an item's location on the screen."

**Hearing an item's location on the screen**

If you have stereo headphones or dual speakers, you can use positional audio to hear audio cues (or sound effects) about an item's location on the screen. This option is on by default.

**To turn on positional audio:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click Sound in the category table and then select the "Enable positional audio" checkbox.

If you have set the Universal Access preference to play stereo audio as mono audio, you can't hear VoiceOver's positional audio.

**Hearing changes in progress or status**

You can hear when the progress bar or status text that's in the VoiceOver cursor changes. For example, while installing software you might hear "Installation 45 percent completed" or you might hear a ticking sound.

**Using a VoiceOver command (for status text only):**

1. To open the rotor to verbosity settings, press VO-V.
   
   These settings include typing echo, punctuation, and text attributes, among others.

2. Press the Left Arrow or Right Arrow key until you hear "when status changes." You also hear the current setting.
3. Press the Up Arrow or Down Arrow key until you hear the setting you want: Play Tone, Speak, Do Nothing.

4. To close the rotor, press Escape.

**Using VoiceOver Utility:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.

2. Click Verbosity in the category table and then click Announcements.

3. For a description of the options for status text and progress bar changes, click the Help button (looks like a question mark) in the lower-right corner.

If you're using portable preferences on a guest computer at the time you change settings, the settings are saved to the portable preferences and not to the guest computer.

---

**Interacting with content areas**

Windows, documents, and webpages have different areas that contain text, files, or other content. When the VoiceOver cursor reaches one of these areas, it identifies the content area. For example, VoiceOver may identify scroll areas, HTML content, lists, outlines, tables, groups, or text areas.

You can navigate past a content area or you can stop and interact with it to read its contents. For example, you can navigate past the Finder sidebar to get to the view browser, or you can interact with the sidebar to open folders and files.

**To start interacting:**

Press VO-Shift-Down Arrow. If you're using VoiceOver gestures, flick right with two fingers on the trackpad.

**To stop interacting:**

Press VO-Shift-Up Arrow. If you're using VoiceOver gestures, flick left with two fingers on the trackpad.

You can interact and stop interacting with an area as many times as necessary. When there's nothing more to interact with, you'll hear a sound effect.

The VoiceOver cursor stays within the boundaries of the area you're interacting with, so you can navigate only within the area.
Selecting and deselecting items
You can select and deselect a single item or multiple items.

To select items:

• For a single item when cursor tracking is off, press VO-Command-F4.

• If you're using VoiceOver gestures, select a single item by double-tapping the trackpad.

• For multiple items, press VO-Shift-F3 to turn off cursor tracking. Then move the VoiceOver cursor to the first item and press VO-Command-Space bar. Move to the next item and press the keys again. Repeat until all the items you want are selected.

To hear the current selection, press VO-F6.

To deselect items:

• For a single item in the VoiceOver cursor, press VO-Command-Space bar.

• If you're using VoiceOver gestures, deselect a single item by double-tapping the trackpad.

• For all selected items, move to one of the items and press VO-Command-F4. To deselect the last and current item, press VO-Command-Space bar.

Hearing when modifier keys are pressed
You can set VoiceOver to speak the name of a modifier key (Shift, Control, Option, Command, and Fn) when you press one. Turning on this option may help you become accustomed to the location of modifier keys on your keyboard, and prevent you from making mistakes.

To hear when a modifier key is pressed:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Verbosity in the category table and then click Announcements

3. Select the "Announce when a modifier key is pressed" checkbox.

Dragging items using the keyboard
You can use the mouse to drag and drop files with mouse tracking turned on or off.

To move items by using the mouse and keyboard:
1. Move the VoiceOver cursor to the item you want to move.

If mouse tracking is off, press VO-Command-F5 to route the VoiceOver cursor to the target location.

2. Verify that the mouse is on the item (press VO-F5).

3. Lock the mouse button (press VO-Command-Shift-Space bar).

4. Move the VoiceOver cursor to the target location.

If mouse tracking is off, press VO-Command-F5 to route the mouse to the target location.

5. Verify that the mouse is on the target location (press VO-F5).

6. Unlock the mouse button (press VO-Command-Shift-Space bar).

**Turning off cursor tracking**

The VoiceOver cursor and keyboard focus are set to follow (or "track") each other. You can turn off VoiceOver cursor tracking to work with the keyboard, mouse pointer, and insertion point independently. For example, with cursor tracking off, you can leave the keyboard focused in a document you're working on and use the VoiceOver cursor to check information elsewhere on your computer, without losing your place in your document.

**To turn off cursor tracking:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Deselect the two checkboxes related to keyboard focus and the VoiceOver cursor.

3. Deselect the two checkboxes related to the insertion point and the VoiceOver cursor.

4. From the "Mouse cursor" pop-up menu, choose "Ignores VoiceOver cursor."

When you're working with cursor tracking off, you can use quick commands if you need to move one cursor to where the other is located.

Refer to "Chapter 2. Learning VoiceOver Basics: Working with cursor tracking turned off."

While you're working, you can disable the cursor tracking options you selected in VoiceOver Utility by pressing VO-Shift-F3. If you press the command again, the cursor tracking options the command disabled are enabled again. The command doesn't change the settings in VoiceOver Utility.
Working with cursor tracking turned off
When you're working with cursor tracking off, you can use quick commands to move one cursor to where the other is located.

Here are ways to synchronize cursors:

• To move the VoiceOver cursor to the keyboard focus, press VO-Shift-F4.

• To move the keyboard focus to the VoiceOver cursor, press VO-Command-F4.

• To move the VoiceOver cursor to where the mouse pointer is focused, press VO-Shift-F5.

• To move the mouse pointer to where the VoiceOver cursor is focused, press VO-Command-F5.

Turning on cursor tracking for the mouse
You can turn on cursor tracking for the mouse so that the focus of the mouse pointer and the VoiceOver cursor match.

To turn on cursor tracking for the mouse:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Navigation in the category table and choose an option from the "Mouse cursor" pop-up menu:

• To make the mouse move with the VoiceOver cursor, choose "Follows VoiceOver cursor."

• To make the VoiceOver cursor follow the mouse, choose the "Moves VoiceOver cursor."

Using VoiceOver Utility
VoiceOver Utility is the application you use to customize VoiceOver's default settings to best suit your needs. It presents an easy-to-navigate list of categories for setting preferences and options.
available to you appear on the right side. Some categories have options organized into panes, which are listed across the top of the right side. You can navigate among the categories and panes using a mouse, the cursor keys, the View menu, or keyboard shortcuts.

A menu bar provides access to commands for exporting and importing preferences, setting up portable preferences, and resetting all or some preferences to their default settings.

Each category or pane contains a Help button in the lower-right corner of the window. Click the button to open a page in VoiceOver online help that explains each option in that category or pane.

**To open VoiceOver Utility:**

- Choose Apple menu > System Preferences, Universal Access, and then click the VoiceOver Utility button.

- Turn on VoiceOver by pressing Command-F5, and then hold down the Control and Option keys (the VO key) and press F8.

---

**Chapter 3. Learning Mac OS X Basics**

This chapter introduces Mac OS X and key features such as the desktop, Finder, Dock, and Spotlight. You’ll learn how to use menus, buttons, and accessibility features that make it easier to use your computer, as well as how to work with applications and windows.

---

**About the Desktop**

The desktop is the background area of your screen. It can display icons for hard disks, CDs, and any servers connected to your computer. You can also store files and folders directly on your desktop for quick access. Using System Preferences, you can customize the appearance of your desktop and choose the types of items shown on the desktop.

---

**Navigating the desktop**

The desktop shows icons for everything it contains, such as your hard disk, folders, documents, and image files. When you open a folder on the desktop, a new Finder window opens automatically.
To navigate the desktop:

- To move to the desktop, press VO-Shift-D.

- To quickly move to an item on the desktop, type the first letter of the item. For example, if you have a file named "travel plans" on the desktop, type "T" to move to it.

- To move around items on the desktop, press the arrow keys.

- To open the selected item on the desktop, press Command-O.

About the Finder

The Finder is the program that manages your files, applications, disks, network connections, and devices such as printers. The Finder is always on when your computer is running, though it may be in the background if you're using another program such as Mail. To display a Finder window, click the Finder icon in the Dock (it's always the first icon in the Dock).

The Finder sidebar contains expanded and collapsed lists. From top to bottom they are: Devices, Shared, Places (expanded and the item "amy" is selected), and Search For.

The view browser shows 9 icons representing 9 items in the place "amy." The icons are displayed horizontally with a name under each icon. From left to right they are: Desktop, Documents, Downloads, Library, Movies, Music, Pictures, Public, Sites.

At the bottom center of the window is: "9 items, 305.93 GB available".

Toolbar buttons and search field

- Use the Back and Forward buttons on the left side of the toolbar to move back and forth between locations on your computer, just as you would in a web browser.

- Use the view buttons to choose how to display the contents of your hard disk and folders in Finder. You can choose icon, list, column, or Cover Flow view.
• Use the Action pop-up menu to choose commands for the item selected in the Finder window. Choices in the Action menu include New Folder, Get Info, or Open.

• Use the search field to type a word or phrase to locate an item. Search results appear in the view browser. You can use the buttons below the search field to focus the search to a particular location.

Sidebar and view browser

• Use the sidebar to display a list of items that you frequently use, including disks, servers, and folders. The list is organized into sections.

The Places section has icons for folders you use most frequently, including your home folder and some folders inside it, such as Documents, Music, and Pictures. The Downloads folder is the default location for any software or files you download from the Internet.

The Search For section includes Smart Folders that collect items meeting specific criteria, such as all files, folders, and applications you used yesterday, or all PDF documents. These folders are useful for quickly finding an item when you've forgotten where it is in your computer's folder hierarchy.

• Use the view browser to view the contents of the folder selected in the sidebar. You can use a toolbar button to view the contents in icon, list, column, or Cover Flow views.

Navigating the Finder

Finder windows display the items on your computer. You use VoiceOver commands or gestures to open and navigate Finder windows. You can use Finder shortcuts to work with selected files and folders.

NOTE: The instructions below assume that cursor tracking is on, and the VoiceOver cursor and keyboard focus are tracking each other.

To open a Finder window:

• Move to the Dock by pressing VO-D or, if you're using VoiceOver gestures, double-tap near the bottom edge of the trackpad. Then navigate to the Finder, which is the first item in the Dock.

• Open the Application Chooser by pressing VO-F1-F1 or, if you're using VoiceOver gestures, double-tap near the left edge of the trackpad. Choose Finder in the Application Chooser. You can also use Mac OS X shortcuts by pressing Command-Tab and then using the arrow keys to navigate to the Finder.
If a Finder window was open, you go to that window. Otherwise, you go to the desktop. In that case, go to the menu bar by pressing VO-M or, if you’re using VoiceOver gestures, double-tapping near the top edge of the trackpad. Then use the Right Arrow key to navigate to the Finder menu.

To navigate a Finder window:

1. In a Finder window, press VO-Right Arrow or VO-Left Arrow to move through the window until you hear "toolbar." Interact with the toolbar.

Refer to "Chapter 2. Learning VoiceOver Basics: Interacting with content areas."

2. Press VO-Right Arrow until you hear "view radio group" and then interact with that control. Press VO-Right Arrow key until you hear the view you want to use.

You can choose from icon, list, column, or Cover Flow view. In Cover Flow view, the browser is split horizontally into two sections. The top section is a graphical view of each item, such as folder icons or a preview of the first page of a document. The bottom section is a list view of the items.

3. When you have selected a view, stop interacting with the view radio group and the toolbar, and then press VO-Right Arrow to move through the window until you hear "sidebar."

4. To move down the list of items in the sidebar, press VO-Down Arrow. When you hear the item you want, jump to it in the view browser: you can interact with it.

To jump, press VO-J. If you’re using VoiceOver gestures, keep a finger on the trackpad and press the Control key.

5. Move to and select the item you want to open, using the method for the view you’re in:

**Icon view:** the arrow keys to move to the item you want.

**List view:** move down the list rows, press VO-Down Arrow. To expand and collapse a folder, press VO-\. To move the VoiceOver cursor across a row and hear information about an item, press VO-Right Arrow. Or press VO-R to hear the entire row read at once.

**Column view:** move down the list until you find the folder or file you want, use the Down Arrow key. To move into subfolders, press the Right Arrow key.

**Cover Flow view:** flip through the items in the top section and move automatically through the corresponding list rows in the bottom section, press the Left Arrow or Right Arrow key.

6. When you find the file or folder you want to open, use the Finder shortcut Command-O or Command-Down Arrow to open it.

VoiceOver announces when you have selected an alias or a file or folder you don’t have permission to open.

To use Finder shortcuts:

- You can use Finder shortcuts to work with selected files or folders.
• To open the selection, press Command-O or Command-Down Arrow.

• To move to the parent of the selection (such as the folder that contains a subfolder you have selected), press Command-Up Arrow.

• To add the selection to the Finder sidebar, press Command-T.

• To add the selection to the Favorites folder, press Control-Command-T.

• To add the selection to the Dock, press Shift-Command-T.

To set a default view for new Finder windows, choose Finder > Preferences, click General, and then select a view from the pop-up menu.

You can temporarily hide the toolbar and sidebar in a Finder window to make it easier to navigate. To hide or show the toolbar and sidebar, click the button in the upper-right corner of the window.

About the Dock
You use the Dock to open applications, documents, folders, and more. By default, it appears across the bottom of the screen.

The Dock comes with icons for some applications, such as Mail and iTunes; you can add others. When you minimize a window or open an application that isn’t in the Dock, its icon appears in the Dock.

Each item in the Dock has a shortcut menu that gives you quick access to commands for that item. The shortcut menu also contains the commands “Remove from Dock” for icons that have been placed there permanently, and “Keep in Dock” for applications that are open but whose icons are only there temporarily.

You can customize the Dock by changing its magnification, repositioning it, and more. To change Dock preferences, choose Apple menu > Dock.

Using the Dock
Use the Dock to open applications, documents, folders, or stacks.

To navigate the Dock:
• To move the VoiceOver cursor to the Dock, press VO-D or Control-F3.
If you’re using VoiceOver gestures, double-tap near the bottom edge of the trackpad. The VoiceOver cursor moves to the Dock regardless of the Dock’s position on the screen.

- To move in the Dock, use the arrow keys. If you’re using VoiceOver gestures, you can flick or drag up, down, left, or right on the trackpad.

- You can also navigate in the Dock by starting to type the name of an application or folder. For example, to move to Mail, start typing its name; the VoiceOver cursor moves to the Mail icon and VoiceOver announces it.

**To use items in the Dock:**

- To move an item in the Dock, hold down the Option key and use the arrow keys to move the item. Each arrow key press moves it one place.

- To open an item in the Dock, press VO-Space bar. If you’re using VoiceOver gestures, double-tap.

- To open a shortcut menu for an item, press VO-Shift-M, and then use the arrow keys to move up and down the shortcut menu. To close the shortcut menu without making a selection, press the Escape key.

- To add an item to the Dock, navigate to the item in Finder or on the desktop and then press Command-Shift-T. The item is added next to the Trash icon.

- To remove an item, open its shortcut menu and choose "Remove from Dock."

**To exit the Dock:**

Press the Escape key. If you’re using VoiceOver gestures, scrub back and forth with two fingers on the trackpad.

To know where the Dock is positioned on the screen, press VO-M to go to the Apple menu. Press VO-Down Arrow to move down the menu until you hear "Dock submenu" and then press VO-Right Arrow. Press VO-Down Arrow to move down the Dock menu until you hear the location of the Dock, such as "Checkmark Position on Bottom."

When hiding is turned on, the Dock is hidden from view until the mouse pointer is over the area where it usually appears (such as the bottom). To make the Dock visible again without moving the mouse pointer, press VO-D.

**About menus and the menu bar**

The menu bar at the top of the screen contains the Apple menu, application menus, status menus, and the Spotlight menu.
• The Apple menu at the left end of the menu bar is always available. It contains commands to get information about your computer and to set system preferences, among others.

• Application menus change to match the active application but typically include File, Edit, Format, Window, and Help menus.

• Status menus display information and provide shortcuts to system and application settings, such as the volume slider, battery level indicator, or Universal Access menu.

• The Spotlight menu is at the right end of the menu bar. Use Spotlight to search your computer for documents, music, and more. You can search for an application and open it from Spotlight.

In Apple's online Help system, the right angle bracket, or greater symbol, is used to describe a sequence of commands or other items in a menu. For example, to open a new Finder window, you open the File menu and choose New. This is written in instructions as "Choose File > New" and spoken by VoiceOver as "Choose File greater New" or "Choose File greater than New." If a command or item is contained in submenus, you hear a series of greater or greater than symbols.

Hearing alternative functions for menu items
You can learn whether a menu item uses modifier keys (such as the Control or Command keys) to provide alternative functions.

To hear if an item has alternative functions:

1. Move the VoiceOver cursor to a menu command.

2. Press a modifier key and listen.

If an alternative function exists when that modifier is used, VoiceOver speaks it.

As you move from one item to another, VoiceOver clears the modifier key you pressed and speaks the default function for the item.

About files and folders
Most of the information in your computer is stored in files. Files include documents, images, applications, and so on. Folders are simply a collection of files. Each file or folder is represented by an icon with its name below or to the right of the icon. You can select the text in the file's name to change it, and you can copy, move, and delete files on your computer.

Your computer comes with some folders already set up, but you can create and delete your own folders to organize your information. Most folders and files you create are stored in a home
folder with your user account name. If you have multiple user accounts on your computer, each user account has its own home folder.

You click once on a file or folder icon to select it and twice to open it. Clicking twice quickly is called “double-clicking.” If you double-click an application icon, you start the application and a window for the application opens. If you double-click a file created by an application, you automatically open the application (if it wasn’t open already) and open the file. For example, if you double-click a TextEdit file on the desktop, TextEdit starts up and its icon appears in the Dock. At the same time, the document opens on the desktop.

If you can’t use a mouse to select and click, you can use VoiceOver commands instead.

**Copying folders and files**

You can copy a file or folder to another location using the Copy and Paste commands in Finder. Copying doesn't remove the original from its original location.

**NOTE:** The instructions below assume that cursor tracking is on, and the VoiceOver cursor and keyboard focus are tracking each other.

**To copy an item to another location:**

1. Open a Finder window and move to the item you want to copy.
   
   Refer to “Chapter 3. Learning Mac OS X Basics: Navigating the Finder.”

2. To copy the item, press Command-C.

3. Move to the folder where you want to paste the item.

   Don’t open the folder; the VoiceOver cursor should be on the folder.

4. To paste the item, press Command-V.

**About System Preferences**

You use System Preferences to customize your computer and choose essential system settings, such as your network configuration and Internet access. System Preferences is located in the Apple menu and has an icon in the Dock.

You can find settings to improve accessibility in these preferences:

- Displays preferences
- Keyboard & Mouse preferences
- Speech preferences
• Universal Access preferences

The easiest way to learn about the many options in System Preferences is to explore the different preference panes. Some preferences have multiple panes you access by clicking the tab buttons. Network preferences even has an “Assist me” button to help you troubleshoot connection problems.

About Spotlight
You can use Spotlight to easily find content on your computer. Spotlight is extraordinarily useful for VoiceOver users. In many cases, it may be easier to use than the Finder for opening files, folders, and applications. When you type text in the Spotlight search field, search results appear immediately in a menu below the search field.

begin image description: A screen shot of the Spotlight menu. At the top left is the Spotlight search field with the word “font” typed in it. Below the search field, the search results appear in a vertical list, beginning with Show All. The remainder of the list is divided into two columns. The left column lists categories, such as Top Hit, Applications, System Preferences, or Documents, and the right column lists the items in each category. At the bottom of the Spotlight menu is Spotlight Preferences, for displaying the preferences. :end image description.

The more complete the word or phrase, the more refined your list of results will be. Search results are grouped by category, such as Applications, System Preferences, Documents, and Folders. You click an item in the list to open it.

If you don't find the item you want, you can search again or click Show All at the top of the results list. Clicking Show All displays a more complete list of results in a new window called the Spotlight window.

Spotlight search results include all the metadata inside files, including the kind of content, the author, edit history, format, size, and many more details. Depending on the search word you type, you may find thousands of results. Spotlight narrows its results to show you the best matches, but you can also browse the entire list if you want.

You can find more information about Spotlight in Mac Help on your computer or on the Apple website at www.apple.com/macosx.

Clicking the mouse
Generally, you select an item by pressing VO-Space bar. But if an item isn't accessible or that VoiceOver command doesn't work as expected, you can simulate a mouse click or double-click using a different VoiceOver command.
To click the mouse:

1. If you don't have "Mouse cursor: Follows VoiceOver cursor" set in VoiceOver Utility, move the VoiceOver cursor to the item you want to click and press VO-Command-F5 to place the pointer on the item.

   If you do, go to the next step.

2. Press VO-Shift-Space bar once for a single mouse click or twice for a double-click.

   You can also use Mouse Keys, a Universal Access feature in Mac OS X, to control mouse movement. Note that you cannot use Mouse Keys when you are using the NumPad Commander.

Using sticky keys
The Sticky Keys feature treats a series of modifier key presses as a single key combination. For example, you can press Control and then Option, and your keyboard interprets that combination as Control and Option held down together.

To turn on sticky keys:

1. Choose Apple menu > System Preferences, click Universal Access, and then click Keyboard.

2. Select the On radio button for Sticky Keys.

   When you turn on Sticky Keys, you can also set options to hear a sound when a modifier key you press is accepted, and display an icon of the symbol for the modifier keys you pressed. Checkboxes for these options are below the Sticky Keys On and Off radio buttons.

Using slow keys
With the Slow Keys feature you can control the amount of time between when a key is pressed and when it is accepted by the keyboard. If you frequently press keys accidentally, you may want a longer delay.

To turn on slow keys:

1. Choose Apple menu > System Preferences, click Universal Access, and then click Keyboard.

2. Select the On radio button for Slow Keys.

3. For a longer delay, move the Acceptance Delay slider to the left; for a shorter delay, move it to the right.

   You can also hear audible feedback when you press keys. You hear one sound when a key is pressed and a different sound when the key is accepted. This is a very good way to monitor what's happening if you can't see the screen. Select the checkbox labeled "Use click key sounds"
under the Slow Keys On and Off buttons to turn on audible feedback.

**Using the cursor control keys**
You can use the mouse, keyboard, and VoiceOver cursor to navigate to text and objects that appear on your screen. VoiceOver uses three function keys to describe the keyboard, VoiceOver cursor, and mouse pointer.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.

**F3—VoiceOver Cursor Key**
To hear a description of the item in the VoiceOver cursor, press VO–F3. This could be a control, text in a document, an HTML content area, and more. The description includes the current state of the item. For example, you might hear that the checkbox is selected, or hear the value settings of a slider.

**F4—Keyboard Focus Key**

- To hear a description of the item on which the keyboard is focused, press VO–F4. The description includes the current state of the item and, if it applies, whether it is enabled or disabled.

- To move the VoiceOver cursor to where the keyboard is focused, press VO–Shift–F4. When you move the keyboard focus, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off.

**F5—Mouse Key**

- To hear a description of what is under the mouse pointer, press VO–F5.

- To hear the location of the mouse pointer as x and y coordinates, press VO–F5–F5. The origin point is the top–left corner of the main display, where the Apple menu is located.

- To hear the location of the mouse in x and y coordinates relative to the current window, press VO–F5–F5–F5.

- To move the VoiceOver cursor to where the mouse pointer is located, press VO–Shift–F5. When you move the mouse, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off, or if you don’t have mouse tracking options turned on in VoiceOver Utility.

- To move the mouse pointer to the VoiceOver cursor, press VO–Command–F5. When you move the mouse again, the VoiceOver cursor does not move with it. Use this command when cursor tracking is turned off, or if you don’t have mouse tracking options turned on in VoiceOver Utility.
Setting the key repeat rate
If you find that keys register more than once when you press them, you can adjust the key repeat rate. The key repeat rate and key repeat delay let you control how fast keys repeat and adjust how long the keyboard waits before it begins to repeat a key press. If you have trouble releasing keys fast enough, you can set the delay very long or turn off the repeat.

To change the key repeat rate:

1. Choose Apple menu > System Preferences, click Keyboard, and then Keyboard.

2. To have keys repeat slowly, move the Key Repeat Rate slider to the left; to have them repeat at a faster pace, move the slider to the right.

If you tend to make mistakes when pressing keys, moving the slider to a slow setting will help minimize the number of repeated keystrokes.

3. To cause a longer delay between when you hold down the key and when the key begins to repeat, move the Delay Until Repeat slider to the left.

To turn off key repeating completely, move the Delay Until Repeat slider all the way to the left.

Using buttons and other controls
You can use VoiceOver commands or gestures to click buttons, select checkboxes, choose an item in a list or menu, and adjust sliders, steppers, and splitters.

Make sure you know where the keyboard focus and VoiceOver cursor are located before you select an item.

Refer to "Chapter 2. Learning VoiceOver Basics: Finding out where the focus is located."

Here are ways to use buttons and controls:

• To select or deselect a control (such as a button, radio button, or checkbox), press VO-Space bar. If Quick Nav is on, press Up Arrow–Down Arrow. If you're using VoiceOver gestures, double-tap on the trackpad.

• To open a pop-up menu, press VO-Space bar. If Quick Nav is on, press Up Arrow–Down Arrow. If you’re using VoiceOver gestures, double-tap on the trackpad.

• To adjust a slider, stepper, or splitter, press VO-Shift–Down Arrow to start interacting with the control. Then use VO-arrow keys to increase or decrease a setting. To stop interacting with the control, press VO-Shift–Up Arrow.

If you’re using VoiceOver gestures, flick right with two fingers on the trackpad to start interacting with the slider or stepper. Then with a single finger, flick up to increase the setting or flick down to decrease the setting. To stop interacting with the control, flick left with two
Hearing open applications and windows
You can hear which applications and windows are open on your computer.

For applications:
To hear which application is active and how many applications are open, press VO-F1.

For windows:
To hear which window is active, press VO-F2.

Switching between applications
When you have more than one application open or more than one window open for an application, you can quickly switch to the application and window you want.

Using the Application Chooser:

1. To open the Application Chooser, press VO-F1-F1. If you're using VoiceOver gestures, double-tap near the left edge of the trackpad.

2. To navigate the list of open applications, press the Down Arrow or Up Arrow key, or flick down or up.

3. When you hear the application you want, press the Space bar or double-tap.

If you used the VoiceOver command to open the chooser, pressing the Space bar opens a submenu that lists all open windows, dialogs, or alerts for the application. Navigate a submenu in the same way you did the list of applications.

To exit the Application Chooser without making a selection, press the Escape key. If you're using VoiceOver gestures, scrub back and forth with two fingers on the trackpad.
Using the standard Mac OS X shortcut:

Hold down the Command key and press the Tab key repeatedly to cycle through the open applications. When you hear the application you want, release the keys. Press Command-Shift-Tab to cycle backward.

If you’re using Spaces, you can use the Spaces shortcut Command-arrow keys to navigate your spaces.

Switching between windows

When you have more than one window open for an application, you can quickly switch between windows.

Using the Window Chooser:

1. To open the Window Chooser, press VO-F2-F2. If you're using VoiceOver gestures, double-tap near the right edge of the trackpad.

2. To navigate the list of open windows, press the Down Arrow or Up Arrow key, or flick down or up.

3. To select the window, press the Space bar or double-tap.

To exit the Window Chooser without making a selection, press the Escape key. If you're using VoiceOver gestures, scrub back and forth with two fingers on the trackpad.

Using the standard Mac OS X shortcut:

Hold down the Command key and press the ' key repeatedly to cycle through the open windows for the current application. When you hear the window you want, release the keys. Press Command-Shift-’ to cycle backward.

Move a window to the front

Sometimes the window where the VoiceOver cursor is located doesn't move to the front of the other windows. If this happens, some of the buttons and controls in the window won't be active. You can use a VoiceOver command to move a window to the front so you can use all the
controls.

To move a window to the front:

Press VO-Shift-F2.

Moving windows and objects
You can move windows and some objects in applications, such as graphics and text boxes.

To move a window or an object:

1. Navigate to the item you want to move and press (for a window) VO-' or (for an object) VO-
Command-'.

VoiceOver tells you if an item can't be moved.

2. To move the window or object up, down, left, or right, use the arrow keys.

To move in smaller increments, press Shift while you use the arrow keys.

3. To stop moving the window or object, press the Escape key.

You can't use other VoiceOver commands until you stop moving the item.

You can use certain number keys to quickly move windows and objects around the screen: the
top left, middle, and right section using keys 1, 2, and 3; the center left, middle, and right
section using keys 4, 5, and 6; and the bottom left, middle, and right section using keys 7, 8,
and 9.

Resizing windows and objects
You can resize windows and some objects in applications, such as graphics and text boxes.

To resize a window or an object:

1. Navigate to the item you want to resize and press (for a window) VO-- or (for an object) VO-
Command--.

VoiceOver tells you if an item can't be resized.

2. In the menu that's displayed, choose an edge or handle.

3. Press VO and the appropriate arrow key to move the selected edge or handle.

To resize in smaller increments, press Shift while you use the arrow keys.
4. To stop resizing the window or object, press the Escape key.

You can't use other VoiceOver commands until you stop resizing.

Chapter 4. Working with Text
Text is found in many places on your computer, such as in windows and dialogs, in content areas like webpages and help files, and in documents. This chapter explains how to use VoiceOver to read, select, and edit text.

Reading text
VoiceOver provides many ways to read text. You can read text a word, line, sentence, or paragraph at a time. You can hear words and characters spelled phonetically.

As you read, you can pause and resume speaking by pressing the Control key. If you're using VoiceOver gestures, tap two fingers on the trackpad.

To read text using VoiceOver commands:

• To read an entire document starting from the top (called "Read All"), press VO–A.

• When you're interacting with a document, to read from the VoiceOver cursor to the bottom of the text area, press VO–A.

• To read a line, press VO–L. To move to the next or previous line, press VO–Down Arrow or VO–Up Arrow.

• To read a paragraph, press VO–P. To move to the next or previous paragraph, press VO–Shift–Page Down or VO–Shift–Page Up.

• To read a sentence, press VO–S. To move to the next or previous sentence, press VO–Command–Page Down or VO–Command–Page Up.

• To read a word, press VO–W. To hear the word spelled, press VO–W again. To hear it spelled phonetically, press VO–W again. To move to the next or previous word, press VO–Right Arrow or VO–Left Arrow.
• To read a character, press VO–C. To hear the character spoken phonetically, press VO–C again. To move to the next or previous character, press VO–Shift–Right Arrow or VO–Shift–Left Arrow.

**To read text using VoiceOver gestures:**

• To read an entire document starting from the top (called "Read All"), flick up with two fingers on the trackpad.

• To read from the VoiceOver cursor to the bottom of the text area, flick down with two fingers on the trackpad.

• To read a word, line, sentence, or paragraph at a time, press the Command key while touching a finger on the trackpad; repeat until you hear the setting you want to use.

When you use the Down Arrow key to move from one line of text to the next, VoiceOver speaks the line where the insertion point is located. Consequently, if you press the Down Arrow key at the first line of a document, VoiceOver won’t read the line because the insertion point has moved to the next line. To hear the first line of text in a document, press VO–Down Arrow.

**Scrolling to content**

When more content is available than can be displayed at one time in a window, you can scroll to the "hidden" content. You can use a VoiceOver command or VoiceOver gestures to scroll content without first interacting with the content.

**To scroll using a VoiceOver command:**

1. Interact with a scroll area.

Refer to "Chapter 2. Learning VoiceOver Basics: Interacting with content areas."

2. To begin scrolling, press VO–Shift–S.

You can't use other VoiceOver commands while you're scrolling.

3. Scroll the content.

To scroll up and down or left and right, press the arrow keys.

To scroll one page at a time, press the Page Up or Page Down key to scroll vertically, and press Shift–Page Up or Shift–Page Down to scroll horizontally.
VoiceOver plays a sound effect when you can't scroll farther in a particular direction.

4. To stop scrolling, press the Escape key.

**To scroll using VoiceOver gestures:**

- To hear the number of pages or rows that are visible on the current page, tap three fingers on the trackpad. VoiceOver speaks something like "Page 4 of 15 and Horizontal page 1 of 2."

- To scroll one page at a time, flick up, down, left, or right with three fingers on the trackpad.

- In the Trackpad Commander pane of VoiceOver Utility, you can select a checkbox to scroll the content (not the scroll bar) down or up. Normally when you move the scroll bar down or up, the content moves in the opposite direction. When the option is selected, the content moves in the same direction you're scrolling.

When you interact with content, the VoiceOver cursor automatically scrolls as it navigates the content.

**Hearing misspelled words in text**
VoiceOver can alert you when it encounters a misspelled word in text.

**To hear misspelled words:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Verbosity in the category table and then click Text.

3. From the "When encountering a misspelled word" pop-up menu, choose an option: Play Tone, Speak Attributes, or Do Nothing.

**Hearing punctuation**
You can change the amount of punctuation you hear, from none to all.

**Using a VoiceOver command:**

1. To open the rotor to verbosity settings, press VO-V.

Verbosity settings include typing echo, punctuation, and text attributes, among others.

2. Press the Left Arrow or Right Arrow key until you hear "punctuation." You also hear the current setting.
3. Press the Up Arrow or Down Arrow key until you hear the setting you want: All, Most, Some, or None.

**All:** all special symbols and punctuation except for spaces. VoiceOver reads a sentence like this, "She turned and stopped comma then started walking again period"

**Most:** all special symbols but not common punctuation, such as the comma and period.

**Some:** keyboard symbols and many math symbols, such as + (plus) sign.

**None:** text as you would normally read it, with pauses for commas and periods.

4. To close the rotor, press Escape.

**Using VoiceOver Utility:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.

2. Click Verbosity in the category table, and then click Text.

3. Move the VoiceOver cursor to the Punctuation pop-up menu and press the Space bar.

4. Press the Up Arrow or Down Arrow key until you hear the setting you want (None, Some, Most, All), and then press the Space bar.

If you’re using portable preferences on a guest computer at the time you change settings, the settings are saved to the portable preferences and not to the guest computer.

**Hearing text attribute changes**

You can change how VoiceOver announces changes in text attributes using a keyboard command or VoiceOver Utility.

**Using a VoiceOver command:**

1. To open the rotor to verbosity settings, press VO–V.

These settings include typing echo, punctuation, and text attributes, among others.

2. Press the Left Arrow or Right Arrow key until you hear "text attributes."

You also hear the current setting.

3. Press the Up Arrow or Down Arrow key until you hear the setting you want: Play Tone, Speak Attribute, Do Nothing.

4. To close the rotor, press Escape.
**Using VoiceOver Utility:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Verbosity in the category table, and then click Text.

3. Move the VoiceOver cursor to the "When text attributes change" pop-up menu and press VO-Space bar.

4. Press the Up Arrow or Down Arrow key until you hear the setting you want and then press the Space bar.

To hear details about the text style closest to the VoiceOver cursor, press VO-T.

If you're using portable preferences on a guest computer at the time you change settings, the settings are saved to the portable preferences and not to the guest computer.

**Hearing text in dialogs**

You can set a preference to control how much description you hear in dialogs. By default, you hear all of the text.

To hear text in dialogs:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Verbosity in the category table and then click Announcements.

3. Specify what you want to hear using the "Automatically speak text in dialog boxes" checkbox:

   - To hear all of the text, such as labels, select the checkbox.
   - To hear only the text to which the VoiceOver cursor moves when the dialog opens, deselect the checkbox.

**Hearing the current selection**

In the Finder and other applications, you must first select the item you want to use. For example, if you want to open a folder, you must first select the folder. You can use a VoiceOver command to quickly find out what, if anything, is currently selected.

To hear a description of the item selected:

Press VO-F6. If you're using VoiceOver gestures, tap the trackpad three times.
If nothing is selected, you hear "No selection available." If text is selected, you hear the text.

**Repeating the last spoken phrase**
If you couldn't clearly hear what VoiceOver said, you can repeat the last spoken phrase.

To hear the last phrase repeated:

Press VO-Z.

You can save the phrase to the Clipboard and as an audio file on your desktop.

**Selecting text**
You can use standard Mac OS X keyboard shortcuts to select text.

**NOTE:** You must have set text selection tracking preferences for moving the keyboard cursor and VoiceOver cursor together in VoiceOver Utility. You can turn on and off your cursor tracking preferences.

Refer to "Chapter 2. Learning VoiceOver Basics: Turning off cursor tracking."

Here are ways to select text:

- To select the character to the right or left of the insertion point, press Shift-Right Arrow or Shift-Left Arrow.

- To select the word to the right or left of the insertion point, press Shift-Option-Right Arrow or Shift-Option-Left Arrow.

- To select the text from the keyboard cursor to the beginning or to the end of the line, press Shift-Command-Right Arrow or Shift-Command-Left Arrow.

- To select the text from the keyboard cursor to the beginning or to the end of the text area, press Shift-Command-Up Arrow or Shift-Command-Down Arrow.

You can delete selected text by pressing the Delete key. If you accidentally delete selected text, use the keyboard shortcut Command-Z to undo the mistake. This correction works only if it occurs immediately after the mistake. This shortcut works in many applications and situations, and is worth trying to see if it corrects a mistake.

If you can't select text using standard Mac OS X keyboard shortcuts, as in an email message that you have received, press VO-Return. Then press VO-arrow keys to read the text you want to select, and then press VO-Return again. The text that was read is highlighted and selected.

To select sections of text that aren't next to each other, first turn off cursor tracking by
pressing VO-Shift-F3. Then move the VoiceOver cursor to the first item and press VO-Command-Space bar. Move to the next item and press the keys again. Repeat until all the text you want is selected.

Hearing what you type
VoiceOver can speak what you're typing. This is known as a "typing echo" and is useful if you're not a confident typist or you want to hear confirmation. You can change the level of typing echo you hear using a keyboard command or VoiceOver Utility. Choose from these settings:

Nothing: doesn't speak what you type.

Characters: speaks each character as you type it (the default setting).

Words: speaks the word you typed when you press the Space bar, a punctuation key, or the Return key (which tells VoiceOver the word is complete).

Characters and Words: speaks each character and completed word.

Using a VoiceOver command:

1. To open the rotor to verbosity settings, press VO-V.

Verbosity settings include punctuation, misspelled words, and text attributes, among others.

2. Press the Left Arrow or Right Arrow key until you hear "typing echo." You also hear the current setting.

3. Press the Up Arrow or Down Arrow key until you hear the setting you want.

4. To close the rotor, press Escape.

Using VoiceOver Utility:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Verbosity in the category table, and then click Text.

3. Move the VoiceOver cursor to the "While typing speak" pop-up menu and press VO-Space bar.

4. Press the Up Arrow or Down Arrow key until you hear the setting you want and then press the Space bar.

If you're using portable preferences on a guest computer at the time you change settings, the settings are saved to the portable preferences and not to the guest computer.
Hearing when caps lock is on
Whenever you press the Caps Lock key, VoiceOver alerts you by playing a tone as you type each uppercase character. In addition, you can have VoiceOver announce when the key is pressed.

To set Caps Lock key notification:
1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click Verbosity in the category table and then click Announcements.
3. Select the “Announce when the caps lock key is pressed” checkbox.

Completing partially entered words
Some applications, such as TextEdit, display a list of possible words for partially entered text. You can use VoiceOver to see this list and select words from it.

To see a word completion list:
1. As you type, enter as many characters as you know, and then press F5 or the Escape key (do not use the VO keys with this command).
2. Press the Down Arrow key until you hear a word that sounds correct.
3. To hear how the word is spelled, press VO-W-W. To hear the word spelled phonetically, press VO-W-W-W.
4. When you hear the word you want to use, press the Space bar.
The word you selected replaces the text you typed.

Checking spelling
Many Mac OS X applications, such as TextEdit and Mail, have a preference you can set to check spelling as you type. As you type a misspelled word, it's underlined.

To check spelling:
1. Move the VoiceOver cursor to a text area and press VO-Shift-Down Arrow to interact with the text in the text area.
2. To move the VoiceOver cursor to the first misspelled word and to hear it, press Command-;.
   To hear the word spelled, press VO=W=W.
Sometimes words that the computer doesn’t recognize are underlined, but they’re not actually misspelled. Continue pressing Command–; until you hear a word that needs to be corrected.

3. To open a shortcut menu of suggested spellings for the misspelled word, press VO–Shift–M.

At the top of the menu are suggested spellings or alternative word choices. Below those are other options, including a dictionary so you can find the definition of the word.

4. Navigate to the corrected spelling you want to use and press VO–Space bar to select it.

If you choose a corrected spelling from the menu, the new spelling replaces the old one. If you don’t hear an acceptable correction, press Escape to close the menu, press VO–Shift–F4 to move the VoiceOver cursor to the misspelled word, and then edit the word manually.

5. To continue to the next misspelled word, press Command–;.

Repeat steps until you have corrected all misspelled words.

6. When you’re done, press VO–Shift–Up Arrow to stop interacting with the text in the text area.

You can also use the Spelling and Grammar panel, found on the Edit menu in most applications. The panel provides additional options, such as a choice of dictionaries. To display the panel, press Command–Shift–;.

---

**Chapter 5. Navigating Content**

VoiceOver provides numerous ways to navigate content and text. In this chapter, you’ll learn how to navigate content such as tables and text, and how to use navigation features such as Quick Nav, the Item Chooser, and hot spots, as well as the Tab key.

---

**Navigating menus**

The menu bar at the top of the screen contains three main areas: the Apple and application menus, status menus, and the Spotlight menu.

**To navigate to the menu bar:**

Press VO–M.

If you’re using VoiceOver gestures, double-tap with two fingers near the top edge of the trackpad.
To navigate in the menu bar:

- To jump from one area (such as status menus) to another (such as the Spotlight menu), press VO-M. To move between menus in an area, press VO-Right Arrow or VO-Left Arrow. You hear a sound effect when you are at the last menu in an area.

- If you’re using VoiceOver gestures, drag a finger across the trackpad to navigate the areas and menus in the menu bar. You hear a sound effect when moving over a blank space. You can also flick left or right to move between menus.

- To quickly move to a menu, type the first letter of the menu. For example, when you’re in the menu bar, type "H" to move to the Help menu.

To navigate a menu:

- To move down or up a menu, press VO-Down Arrow or VO-Up Arrow. If you’re using VoiceOver gestures, drag a finger down or up on the trackpad.

- To move to a submenu, press VO-Right Arrow. To return to the main menu, press VO-Left Arrow.

If you’re using VoiceOver gestures, flick right or left on the trackpad.

To close a menu:

To exit a menu without selecting an item, press Escape. If you’re using VoiceOver gestures, scrub back and forth with two fingers on the trackpad.

Shortcut menus give you quick access to commands so you don’t have to navigate to the menu bar. To open a shortcut menu for an item, press VO-Shift-M. If you’re using VoiceOver gestures, you can use the customized gesture Control–Trackpad click (you can change this default assignment and assign the command to a different gesture).

Many menu items have keyboard shortcuts you can use to bypass menus altogether. For example, to open the Print window, press Command–P, instead of navigating to File > Print.

Navigating tables

You can navigate tables in text areas by row and column, and sort by column.

Here are ways to navigate tables:

- To hear the contents of a table row from the location of the VoiceOver cursor to the end of
the row, press VO-R.

- To hear the contents of a table column from the location of the VoiceOver cursor to the bottom of the column, press VO-C-C.

- To hear the column header, press VO-C.

- To sort the column, position the VoiceOver cursor on the column and press VO-|.

- To move up or down in a column, press the Up Arrow or Down Arrow key.

- To move to the parent row of the current column, press VO-Command-\ .

You can use the same text commands you would use for documents to read text in a table.

When you're interacting with a table, VoiceOver doesn't announce blank columns as you navigate using the arrow keys unless you have the verbosity level for tables set to High.

**Navigating by finding text**

You can navigate in a window by searching for specific text. For example, if you're working in Mail and you want to go to the Send button, type Send in the VoiceOver search field and the VoiceOver cursor will move directly to that button.

**To search text:**

1. Press VO-F.

   VoiceOver displays a search panel.

2. In the search panel, type or paste (by pressing Command-V) the text you're looking for, and then press Return.

   VoiceOver searches from the VoiceOver cursor to the end of the text area.

   - To find the next occurrence of the text in the window, press VO-G.

   - To find the previous occurrence of the text in the window, press VO-Shift-G.

3. To review past searches, press the Up Arrow or Down Arrow key. Before you repeat, delete, or enter a new search, press VO-F.

   - To repeat a previous search, press Command-A.

   - To delete a search, press Command-Delete.
Navigating by using text attributes
You can navigate in a document by searching for text attributes, such as a bold font or a change in font color.

Here are ways to navigate by using text attributes:

• To find the next instance of the specified attribute, press the keys indicated:

  **Bold text**: Command-B

  **Font change**: Command-O

  **Text that has the same style as the current text**: Command-S (if you are not in a text area, VO-Command-S finds the next item that is the same as the current item)

  **Style change**: Command-C

  **Italic text**: VO-Command-I

  **Color change**: Command-K

  **Underlined text**: Command-U

  **Plain text**: Command-P

  **Graphic**: Command-G

  **Link**: VO-Command-L

• To find the previous instance of an attribute, use the same commands with Shift, as in VO-Command-Shift-B or VO-Command-Shift-L.

Navigating using cursor wrapping
When you use cursor wrapping, VoiceOver treats the items in a window as a continuous loop, so, for example, if you’re at the top and move back, you go to the last item in the window. You hear cues when you wrap to the next line, or wrap from top to bottom or from bottom to top.

You can set a preference in VoiceOver Utility to turn on cursor wrapping so that it’s always available. If you don’t set the preference, you can use commands that force cursor wrapping only when you need it.

To use cursor wrapping at any time:

1. When VoiceOver is on, open VoiceOver Utility, click Navigation, and select the "Allow cursor wrapping" checkbox.
2. To wrap from the bottom to the top of a window, press VO-Down Arrow. To wrap from the top to the bottom of a window, press VO-Up Arrow.

**To use cursor wrapping when needed:**

1. To move the cursor to the lower-right corner or to the top of a window to prepare for wrapping, press VO-Command-End or VO-Command-Home.

2. To wrap to the top or to the bottom, press VO-Command-Shift-arrow keys.

For example, VO-Command-Shift-Left Arrow wraps from the first item in a window to the last item in the window.

**Navigating with the Tab key**

Mac OS X includes "full keyboard access," where you can use the Tab and arrow keys to move the keyboard focus to text boxes, lists, radio buttons, checkboxes, and other controls.

Here are some points to keep in mind when you use the Tab key to navigate while VoiceOver is on:

- The Tab key may not move to all controls, like the VoiceOver cursor does. The Tab key may move to only text boxes and lists, depending on how you've set an option in Keyboard Shortcuts in Keyboard system preferences (or if you've used the shortcut Control-F7 to turn the option on or off while working).

- When you use the Tab key to navigate and the VoiceOver cursor lands on an item, you immediately interact with the item (you don't need to enter a command to interact with it). For example, when you tab into the mailbox list in Mail, you can automatically interact with the mailboxes.

You can turn off this automatic interaction in the Navigation category in VoiceOver Utility.

You can navigate in reverse using Shift-Tab.

**Navigating using Quick Nav**

With Quick Nav, you can navigate webpages and applications using only the arrow keys.

**To turn Quick Nav on or off:**

Press the Left Arrow and Right Arrow keys at the same time.
To navigate applications and webpages in Group mode:

- To move left, right, up, or down, press an arrow key. With Quick Nav, these keys function the same as pressing the VO-arrow keys.
- To start interacting with an item, press the Right Arrow and Down Arrow keys at the same time.
- To stop interacting with an item, press the Left Arrow and Down Arrow keys at the same time.
- To perform the default action on the item in the VoiceOver cursor, press the Up Arrow and Down Arrow keys at the same time.

To navigate webpages in DOM mode:

- To move left or right on the page, press the Left Arrow or Right Arrow key.
- To jump to the next or previous item in the current list in the Web Item rotor, press the Up Arrow or Down Arrow key.
- To jump to the next or previous list in the Web Item rotor, press the Left Arrow and Up Arrow keys or the Right Arrow and Up Arrow keys at the same time.

Navigating using the Item Chooser
You can use the Item Chooser to quickly go to any item on the screen or in a window. The Item Chooser menu lists text, controls, links, and graphics.

To navigate to an item:

1. Press VO-I to display the Item Chooser.
2. Navigate the items in the list using the Up Arrow or Down Arrow key until you find the item you want.
3. If you know the name of an item, such as a Close button, type some letters of its name to narrow the list to only items that contain those letters. To list all the items again, press the Delete key.
• If you don't find the item you want, press the Escape key to exit the Item Chooser without making a selection.

3. Press Return or the Space bar to select the item and go to it.

The Item Chooser closes.

Monitoring items with hot spots
You can use hot spots to monitor up to ten items per window or to jump to those items later. After you set a hot spot for an item, you can use the hot spot until you close the window that contains the item. If you turn off VoiceOver and then later turn it on and open a window in which you previously set hot spots, your hot spots are still available.

To set a hot spot:

Navigate to the item and press VO-Shift-[number key].

If you assign a number that's already being used in a hot spot, the new hot spot replaces the old one.

To remove a hot spot:

Press VO-Shift-[number key] on the hot spot.

For example, if you had set a hot spot on the first icon in the Dock (say, by pressing VO-Shift-5), you would press VO-5 to jump to that hot spot and then press VO-Shift-5. VoiceOver removes the hot spot from the icon.

To use hot spots:

• To jump to a hot spot, press VO-[number key].

• To hear a description of a hot spot, press VO-Command-[number key].

• To watch for value changes in a hot spot, press VO-Command-Shift-[number key].

VoiceOver announces whenever the watched item's value changes. When you no longer want to hear value changes, press the command again.

When you jump to hot spots in tables, lists, or web areas, you can immediately interact with those items; you don't need to enter a VoiceOver command to interact with them.

To use the Hot Spot Chooser to browse and jump to hot spots, press any hot spot key twice. For example, you might press VO-7-7 to display the Hot Spot Chooser. The Hot Spot Chooser lists all active and inactive (those in closed applications) hot spots.
You can use hot spots on some non-English keyboards.

You can assign hot spot commands to keys on the numeric keypad or keyboard, or on a braille display. If you're using a Multi-Touch trackpad, you can assign the commands to VoiceOver gestures.

Chapter 6. Browsing the Internet
This chapter provides information about using VoiceOver to browse and navigate webpages effectively using two different navigation modes, tables, images, frames, and web spots, as well as the VoiceOver Web Item rotor.

Browsing webpages
When you browse webpages using VoiceOver, you can hear a summary of webpage statistics that tells you how many headers, links, tables, and more are on the page. This information can help you assess the scope and structure of the webpage and navigate in ways that best suit the webpage.

Here are ways to navigate:

• You can choose a default navigation mode, by Document Object Model (DOM) or by grouping related items. You can switch between modes to use the one that works best for the current webpage.

Refer to "Chapter 6. Browsing the Internet: Navigating webpages using DOM or group mode."

• You can use the Web Item rotor to quickly jump to links, headers, web spots, tables, and more on a webpage.

Refer to "Chapter 6. Browsing the Internet: Navigating webpages using the Web Item rotor."

• If you're using VoiceOver gestures, you can use the web settings of the gestures rotor to navigate webpages more easily.


• With Quick Nav, you can navigate webpages and applications using only the arrow keys.
• As VoiceOver opens a webpage, it evaluates the visual design and creates web spots to mark locations on the page. You can jump from one web spot to another, hearing the beginning of the content in each web spot, essentially scanning the webpage for content of interest. You can create your own web spots to mark favorite locations on a webpage and navigate there more quickly.

Refer to “Chapter 6. Browsing the Internet: Navigating webpages using web spots.”

• You can hear a summary of a table and its cells as you press the arrow keys to navigate the table. You don’t need to interact with the table unless you hear something that you want to explore in detail.

Refer to “Chapter 6. Browsing the Internet: Navigating tables on webpages.”

To hear the summary of statistics for the current webpage, press VO-Shift-I. Or set the option in the Web category in VoiceOver Utility to have the summary automatically read when a webpage opens. VoiceOver speaks statistics only for the items you have included in the Web Item rotor.

Refer to “Chapter 9. Customizing VoiceOver: Customizing the Web Item rotor.”

Web developers can assign keyboard shortcuts, called “access keys,” to webpage items such as links and buttons, to make them easier to interact with. VoiceOver can notify you when it detects access keys. For example, if VoiceOver detects an access key on a link, it might say “Access key available: s,” where “s” is the access key. You can then press Control-S to open the link. To hear access keys, you must select the option to speak help tags in the Hints pane of the Verbosity category in VoiceOver Utility.

Navigating webpages using DOM or group mode
VoiceOver provides two modes for navigating webpages: by a webpage’s Document Object Model (DOM), or by grouping related items. Navigating by DOM moves left and right, in the order set by the webpage’s author. (Moving up and down in DOM mode is based on the current setting of the Web Item rotor.) Navigating by group moves in any direction, to help give you a sense of context.

You set the default web navigation mode in VoiceOver Utility, but you can easily switch modes to best suit the current webpage.

To set the default navigation mode:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.
2. Click Web in the category table and then select a web navigation mode.

**To switch modes:**

- Press VO-H-H to display the Commands menu, type "dom" to narrow the list of commands, and then select the "Toggle Web Navigation DOM or Group" command.

- In VoiceOver Utility, in the NumPad or Keyboard Commander, or the Input pane for braille displays, assign the "Toggle Web Navigation DOM or Group" command to a key. Then use that key while navigating webpages.

**When navigating by DOM:**

You don't need to interact with a list to navigate the list items. Just press VO-arrow keys to navigate list items.

**When navigating by grouping items:**

- You don't need to interact with groups that contain only one item.

- You need to interact with a list to navigate the items in the list.

When you navigate to a list, VoiceOver indicates the number of items in the list and when it has reached the end of the list.

If you're using VoiceOver gestures, the current web navigation mode affects how you navigate webpages using the rotor. In DOM mode, flicking up or down on the trackpad moves to the previous or next instance of the item that matches the current rotor setting. For example, if the rotor is set to headers, flicking up or down moves to the previous or next header. In grouping related items mode, flicking up or down moves to the previous or next group of related items. You can assign the "Toggle Web Navigation DOM or Group" command to a gesture using the Trackpad Commander, to easily switch modes to suit your needs.

Refer to "Chapter 11. Using VoiceOver Gestures: Assigning VoiceOver commands to gestures."

**Navigating images on webpages**

Webpages typically contain images, some of which may be used as links. Images may include a description of the image, called "alt text." You can set an option to navigate only to images that contain alt text, to never navigate to images, or to always navigate to images.

**To customize image navigation:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click Web in the category table and then choose an option from the "Navigate images" pop-up menu.

For a description of the options, click the Help button (looks like a question mark) in the lower-right corner.

To navigate to images:

- To jump to the next or previous graphic, press VO-Command-G or VO-Command-Shift-G.

- If you included images in the Web Item rotor, you can use the rotor to move to a specific image.

Refer to "Chapter 6. Browsing the Internet: Navigating webpages using the Web Item rotor."

When you navigate to images that don't have image descriptions (called "alt text"), VoiceOver speaks the image filenames. You can create a custom label for these images, or for images whose alt text isn't useful.

Refer to "Chapter 9. Customizing VoiceOver: Creating custom labels."

If you included images in the Web Item rotor, you can listen to the webpage summary to hear how many images are on the current webpage. To hear the summary, press VO-Shift-I.

Navigating tables on webpages

Tables are used extensively on webpages for visual layout and to present data. You can choose to navigate data tables by grouping items within the tables. When navigating tables by grouping, you hear a summary of a table and its cells as you press the arrow keys to navigate the table. You don't need to interact with the table unless you hear something that you want to explore in detail. You can use a VoiceOver command to turn the setting on or off to best suit the current table.

To set table navigation by grouping:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Web in the category table and select the "Group items within" checkbox.

To turn on or off grouping for the current table:

Press VO-=.

Only the current table is affected by this command; other tables you navigate to will use the setting as specified in VoiceOver Utility. VoiceOver remembers the setting for the current table.
and will use it each time you navigate to the table.

**To navigate tables by grouping:**

- To move to the first cell in the table, press VO-Home. To move to the last cell, press VO-End.

- To move from the table to the first item on the webpage, press VO-Shift-Home. To move to the last item on the webpage, press VO-Shift-End.

- When you're on a cell in the last row and press the Down Arrow key, VoiceOver wraps to the first row of the next column.

- To exit a table when you're on the first cell, press the Up Arrow or Left Arrow key. When you're on the last cell, press the Down Arrow or Right Arrow key.

When you're navigating tables without grouping, you can navigate more quickly to the next column by pressing VO-Command-Y or navigate to the previous column by pressing VO-Command-Shift-Y.

**Navigating webpages using web spots**

As VoiceOver opens a webpage, it evaluates the visual design, groups items based on the design, and creates a web spot on the first item in each group on the screen. VoiceOver briefly outlines the group with a large rectangle, which transitions into the VoiceOver cursor, positioned on the first web spot in the group.

You can jump from one web spot to another, hearing the content in each web spot, essentially scanning the webpage for content that interests you.

You can create your own web spots to mark favorite content on a webpage (say, the top headlines or sports scores) and navigate there more quickly. If you mark a spot as the "sweet spot," it appears first in the list of web spots in the Web Item rotor.

**To use web spots:**

- The VoiceOver cursor must be in a web area, such as in Safari or the iTunes Store.

- To jump to the next auto web spot, press VO-Command-N. To jump to the previous auto web spot, press VO-Command-Shift-N.

- To jump to the next web spot, press VO-Command-. To jump to the previous web spot, press VO-Command-[].

**To create a web spot:**

Press VO-Command-Shift-. 
To remove a web spot:

Press VO-Command-Shift-\{.

To set the sweet spot:

Press VO-Command-Shift-\}--}. 

To open the Web Item rotor to use the list of web spots, press VO-U. You can use the rotor with VoiceOver gestures.


If you have the VoiceOver Utility preference set to move the VoiceOver cursor to a webpage whenever a page opens, the cursor will be on the sweet spot.

You can create an unlimited number of web spots for a webpage. You can delete web spots you create, but you can’t delete auto web spots. If the design of a webpage changes significantly and VoiceOver can’t locate an existing auto web spot or web spot, it creates a new one that closely matches the original one.

Navigating webpages using frames

Some webpages organize information into separate areas called "frames." Sometimes one frame has links in it that update the contents of other frames on the page. You may find it easier to navigate these webpages using frames.

Here are ways to navigate frames:

- To move to the next frame, press VO-Command-F.
- To move to the previous frame, press VO-Command-Shift-F.
- If you included frames in the Web Item rotor, you can use the rotor to move to a specific frame.

Refer to "Chapter 6. Browsing the Internet: Navigating webpages using the Web Item rotor."

If you included frames in the Web Item rotor, you can listen to the webpage summary to hear how many frames are on the current webpage. To hear the summary, press VO-Shift-I.
Navigating webpages using the Web Item rotor

When you browse a webpage, you can display the Web Item rotor and use it to jump directly to a specific heading, table, link, or other item on the webpage.

To navigate to items:

1. While browsing a webpage, open the Web Item rotor by pressing VO-U.

2. Navigate the lists using the Right Arrow or Left Arrow key until you hear the list you want, such as Headers or Links.

If you're using Quick Nav, press Left Arrow-Up Arrow or Right Arrow-Up Arrow to move through the lists.

3. Navigate the items in the list using the Up Arrow or Down Arrow key until you find the item you want.

   • If you know the name of an item in a list, type some letters of its name to narrow the list to only items that contain those letters. If you're in the Headers List, you can type the heading level (such as 3) to narrow the list to only headings of that level.

   To show all items in the list again, press the Delete key.

   • If you don't find the item you want, press the Escape key to exit the rotor without making a selection.

4. Press Return or the Space bar to select the item and jump to it on the webpage.

The Web Item rotor closes.

You can choose the types of items that are listed in the Web Item rotor.

Refer to "Chapter 9. Customizing VoiceOver: Customizing the Web Item rotor."

If you're using VoiceOver gestures, you can access the web-related rotor settings with a gesture.


Chapter 7. Using Mac OS X Applications

Mac OS X comes with many accessible applications that you can use with VoiceOver, such as Mail, iChat, and iTunes. This chapter provides information about using some of the Mac OS X applications.
For information about other applications that are compatible with VoiceOver, visit the VoiceOver Application Support webpage at:

www.apple.com/accessibility/voiceover/applications.html

Navigating in Mail
The Mail window is organized like a Finder window. A table on the left contains your mailboxes. As you move up or down the mailboxes table, the contents of each mailbox are listed in a column on the right. Below the messages list is a splitter and then a pane for previewing the selected message.

To navigate mailboxes and messages:

1. When the VoiceOver cursor is on the mailboxes table, interact with the table.

   Refer to “Chapter 2. Learning VoiceOver Basics: Interacting with content areas.”

2. To move to a mailbox, press VO-arrow keys.

   To expand or collapse a mailbox to navigate to mailboxes within it, press VO-\.

3. When the mailbox whose messages you want to read is in the VoiceOver cursor, jump to the messages table.

   Press VO-J. If you’re using VoiceOver gestures, keep a finger on the trackpad and press the Control key. To jump back to the mailboxes table, repeat the command or the gesture.

4. Move across or down each row in the table by pressing VO-arrow keys.

   To hear a description of everything in that row, press VO-R.

5. When the VoiceOver cursor is on a message you want to read, jump to the message preview.

   Press VO-J. If you’re using VoiceOver gestures, keep a finger on the trackpad and press the Control key. To jump back to the messages table, repeat the command or the gesture.

Addressing messages in Mail
When you start typing email addresses in a New Message window in Mail, some recipient names may appear as Smart Addresses. Smart Addresses are names and addresses that are in your address book, your Previous Recipients list, or available mail servers. Smart Addresses show the name within a blue field, which includes a pop-up menu of related commands, such as Reply to Sender or New Message.
To address a message:

1. In Mail, open a New Message window.
   The window opens with the VoiceOver cursor in the To field.

2. Start typing the recipient's email address.
   You hear the name and email address of the first name that matches what you're typing. If more
   than one address is available for the recipient, you hear "Mail has new window" and a pop-up
   menu of addresses becomes available. Use the Down Arrow or Up Arrow key to navigate the list
   of addresses.

3. To enter the selected address in the field, press Return.
   To delete an address you just entered, press the Delete key once to highlight the address and a
   second time to delete it. If a recipient has a Smart Address, you hear "menu button," which
   refers to the pop-up menu in the Smart Address.

4. To add another address, repeat steps 2 and 3.
   You can add as many addresses in the field as you want. If you enter multiple addresses that
   aren't Smart Addresses, separate them with a comma.

5. To move to the next text field, press VO-Down Arrow.
   To open the pop-up menu in a Smart Address, press VO-Shift-M.
   If it's easier to type email addresses than to use Smart Addresses, turn off Smart Addresses. In
   Mail, choose Mail > Preferences > Viewing, and then deselect the "Use Smart Addresses"
   checkbox.

Reading messages in Mail
You can use VoiceOver commands or gestures to read messages in Mail.

To read a message in Mail:

1. Move the VoiceOver cursor to the message you want to read in the messages list.

2. Jump to the message preview to start reading the message.
   Press VO-J. If you're using VoiceOver gestures, keep a finger on the trackpad and press the
   Control key.

3. When you're done reading, jump back to the messages list.
   Press VO-J, or keep a finger on the trackpad and press the Control key
   To quickly read through the messages list, press VO-Shift-Down Arrow to interact with it. Then
press VO-Right Arrow or VO-Left Arrow until you're in the column you want to hear, such as the Subject column, and then press the Down Arrow or Up Arrow key to move up or down in that column.

**Using data detectors in Mail messages**
Mail can detect specific information or data in messages and makes it easier for you to use the data. For example, Mail can recognize phone numbers and add them to your address book, or recognize a date and time and create an iCal event for it.

**To detect data:**

1. In a message you've received, move the VoiceOver cursor over a phone number, email address, street address, date, or time.

Mail outlines the data as a field with a pop-up menu, and VoiceOver speaks "data detector present."

2. To open a shortcut menu that contains commands for using the data, press VO-Shift-M.

For example, if the data detector is an email address, you can choose New Message from the shortcut menu to open a New Message window that already has the email address in the To field; you don't need to retype or add the email address yourself.

**Accepting iChat invitations**
If you set iChat preferences to announce when a new invitation arrives and to speak message contents automatically, you'll hear "Chat invitation from [buddy name]" when you're invited to chat, followed by the text of the new message, and finally "iChat has new window." You can ignore the message if you're busy or you can switch to iChat and accept the invitation.

**To accept an iChat invitation:**

1. Press VO-F1 twice to open the Application Chooser menu.

2. Press VO-Down Arrow until you hear iChat, and then press VO-Space bar to select the command.

3. Press VO-Down Arrow until you hear "Chat with [buddy name] new" and then select the command.

The VoiceOver cursor moves to the iChat invitation window.

4. Type your response in the text field.

If you set the initial position of the VoiceOver cursor to be the first item in a window in VoiceOver Utility, you must navigate to and select the Accept button at the bottom of the
window before you can type your response.

5. Press Return to send your response.

You interact with the iChat window the same way you do with other windows. All the messages in a text chat, including yours, are displayed above the text field in an HTML content area. You can interact with the area to move up and down the messages and read them.

**Hearing iChat invitations and messages**

You can set iChat preferences so that iChat announces when a new chat invitation arrives, and speaks the text of new chat messages. You can also set alert preferences for other events and types of chats, such as audio and video chats.

To set iChat to speak invitations and messages:

1. In iChat, choose iChat > Preferences, and then click Alerts.

2. To hear incoming invitations, click the Event pop-up menu and choose Text Invitation.

3. Select the "Speak an announcement" checkbox.

4. To hear incoming messages, click the Event pop-up menu again and choose Message Received, and then repeat step 3.

Now when you receive a chat invitation, you'll hear "Chat invitation from [buddy name]," followed by the text of the new message, and finally "iChat has new window." You can choose to ignore it if you're busy or you can accept the invitation.

When cursor tracking is turned on, iChat speaks incoming messages only when you're focused on the message portion of the chat window; if you're typing a message in the text field, incoming messages are not spoken. You can turn off cursor tracking while using iChat, which enables you to move the VoiceOver cursor to the message portion to hear incoming messages, while the keyboard focus remains in the text field where you're typing.

Refer to "Chapter 2. Learning VoiceOver Basics: Turning off cursor tracking."

You can use hot spots to be alerted of incoming messages.

Refer to "Chapter 5. Navigating Content: Monitoring items with hot spots."

**Navigating iChat messages**

You can use a VoiceOver command or gesture in iChat to jump between the text field where you type your message and the table of incoming messages. This is useful if you want to review
what your buddy said before you send your own message.

To use the jump command in iChat:

1. When the VoiceOver cursor is in the text field, press VO-J. If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key.

The VoiceOver cursor jumps to the end of the last message in the HTML content area.

2. To navigate the messages, press VO-Shift-Up Arrow or VO-Shift-Down Arrow.

3. To move the VoiceOver cursor back to the text field, press VO-J. If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key.

The next time you jump during the same chat, the VoiceOver cursor will move to the last message you read.

You can turn off cursor tracking while using iChat, which enables you to move the VoiceOver cursor to the message portion to hear incoming messages, while the keyboard focus remains in the text field where you're typing.

Refer to "Chapter 2. Learning VoiceOver Basics: Turning off cursor tracking."

Using iTunes
You can use VoiceOver with iTunes 8 to navigate the iTunes Store to buy music, movies, TV shows, and audiobooks, or download free podcasts. You can use all of the general VoiceOver commands to navigate the iTunes window. You interact with toolbars and lists just as you would in any other window.

To learn more about accessibility solutions for iTunes, open iTunes and search the iTunes Help for "accessibility." Or visit the iTunes accessibility website at:

www.apple.com/accessibility/itunes/vision.html

Changing tab stops in TextEdit
You can click tab stop buttons located at the right end of the TextEdit toolbar to add new tab stops. When the VoiceOver cursor is in the ruler, you can add or move tab stops.

If the ruler isn't available, open TextEdit preferences and make sure the "Show ruler" checkbox is deselected.
To add or change a tab stop:

1. When the VoiceOver cursor is on a tab stop button or in the ruler, press VO-Space bar.

2. In the dialog that appears, press VO-Right Arrow to navigate to the Right Tab Stop pop-up menu, and then press VO-Space bar again to open the pop-up menu.

3. Press VO-Down Arrow or VO-Up Arrow to find the type of tab stop you want to add, and then press VO-Space bar to select it.

4. Press VO-Right Arrow until you reach the edit text field for the ruler marker value.

5. Type the measurement for where you want to place the tab stop. For example, 6.25 indicates six and one quarter inches on the ruler.

6. Press VO-Right Arrow until you reach the OK button and click it.

To drag a tab stop to another location:

1. Navigate to the ruler and locate the marker for the tab stop you want to move.

2. Start interacting with the marker by pressing VO-Shift-Down Arrow.

3. Press VO-Left Arrow or Right Arrow until the marker is located where you want it.

4. Stop interacting with the marker by pressing VO-Shift-Up Arrow.

Using Front Row to play media

Front Row is self-speaking; you don’t use VoiceOver commands to control it. Front Row uses your default VoiceOver voice to speak what’s on the screen in the Front Row menu; it outputs what’s on the screen to an available braille display. You navigate the Front Row menu just as you would other menus that you’re familiar with.

Here are tips to help you use Front Row:

- You can use keyboard shortcuts to control Front Row.

To open Front Row, press Command-Escape. To exit, press Escape. To navigate in Front Row, use the arrow keys. To select an item, press Return.

- When you change to a new screen, you hear the title of the screen and then the selected item.

- When you change items, Front Row speaks the new item.

- When the selection rests on an item for several seconds, Front Row speaks details about the item, if details exist.
If your Mac computer includes Apple Remote, you can use the remote to change the sound volume, navigate lists and menus, start and pause playback, and more. For more information about Front Row, open Mac Help and search for Front Row.

**Automating tasks with AppleScript**

Many tasks, including those using VoiceOver, can be automated by writing scripts using the AppleScript programming language included in Mac OS X. After you enable VoiceOver to work with scripts, you can use AppleScript Editor to open the VoiceOver AppleScript dictionary of terms available to use in scripts.

**To enable using scripts:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click General and select the "Allow VoiceOver to be controlled with AppleScript" checkbox.

**To open the VoiceOver AppleScript dictionary:**

1. Open AppleScript Editor.

You can use Spotlight to search for it and then select it from the search results.

2. Choose File > Open Dictionary and then choose VoiceOver at the bottom of the alphabetical list.

You can assign AppleScript scripts to keys on the numeric keypad or keyboard, or on a braille display. If you're using a Multi-Touch trackpad, you can assign the scripts to VoiceOver gestures.

---

**Chapter 8. Collaborating with Other Users**

This chapter explains how to use features that enhance collaboration between users. You'll learn about the caption panel, the braille panel, the screen curtain, and tiling visuals. You'll also learn how to mute speech and sound effects.

---

**Using the caption panel**

You can display a panel on the screen that shows what VoiceOver is speaking. The caption
panel is helpful when you’re sharing the computer with those around you who are sighted.

To show or hide the panel:

- Press VO-Command-F10.
- When VoiceOver is on, open VoiceOver Utility, click the Visuals category, and then click Caption Panel.

For a description of the option to show the caption panel and other options to customize it, click the Help button (looks like a question mark) in the lower-right corner.

To show or hide the caption panel and the VoiceOver cursor, press VO-F11.

To move or resize the panel:

1. Press VO-Shift-F10 until you hear the action you want to perform.

For example, if you hear "resizing" but you want to move the caption panel, press the keys again to hear "moving."

2. Press VO-arrow keys to move or resize the caption panel. To move or resize in smaller increments, press Shift with the arrow keys.

3. When you're done, press the Escape key.

When the caption and braille panels are displayed at the same time, they can sometimes obscure each other; try moving or resizing them.

Refer to "Chapter 8. Collaborating with Other Users: Using the braille panel."

**Using the screen curtain**

For added privacy, you can prevent those around you from reading the screen by using the screen curtain, which temporarily turns the screen black. The screen curtain is also useful for sighted users who want to avoid reading the screen while learning to use VoiceOver.

To turn on the screen curtain:

Press VO-Shift-F11. If you're using VoiceOver gestures, triple-tap with three fingers anywhere
on the trackpad.

Repeat the command or gesture to turn off the screen curtain so the screen is visible again.

If you turn off VoiceOver while the screen curtain is on, the screen curtain is also turned off.

**Using the braille panel**

You can show a panel on the screen that simulates a refreshable braille display, even if you don’t have a braille display, along with a language translation of the braille. Sighted and nonsighted users can read the same text at the same time.

---

**begin image description:** A screen shot of the braille panel. A panel with a black background containing a rectangle outlined in white. The rectangle contains braille characters, in yellow, that represent the item in the VoiceOver cursor and that would be displayed on a refreshable braille display. Under the rectangle from left to right, in white, are the English word equivalents of the braille characters: For more than 20 years,.

---

You can set options to control the panel’s appearance and whether to show it whenever a braille display is connected to or paired with your computer, and you can move and resize it. When resized, the braille panel can show more cells than may be on the connected braille display; in this case, a thin rectangular line around some cells indicates the physical braille cells of the display.

**To show or hide the panel:**

- When VoiceOver is on, open VoiceOver Utility, click the Visuals category, and then click Braille Panel.

For a description of the option to show the braille panel and other options to customize it, click the Help button (looks like a question mark) in the lower-right corner.

- Press VO-Command-F9.

This command also changes the setting in VoiceOver Utility. If you had set the option to automatically show the braille panel when a braille display is connected or paired with your computer, you must choose that setting again in VoiceOver Utility.

To show or hide the braille panel and the VoiceOver cursor, press VO-F11.

**To move or resize the panel:**

1. Press VO-Shift-F9 until you hear the action you want to perform.

For example, if you hear "resizing" but you want to move the braille panel, press the keys again to hear "moving."

2. Press VO-arrow keys to move or resize the braille panel. To move or resize in smaller
increments, press Shift with the arrow keys.

3. When you're done, press the Escape key.

The braille panel displays what's on the screen even when you mute speech.

When the braille and caption panels are displayed at the same time, they can sometimes obscure each other; try moving or resizing them.

Refer to “Chapter 8. Collaborating with Other Users: Using the caption panel.”

Tiling visuals
You can tile visuals (the VoiceOver cursor, the caption and braille panels, and VoiceOver menus) on the screen. When you tile visuals, the VoiceOver cursor moves to the center of the screen and the rest of the screen is dimmed.

begin image description: A screen shot of the screen curtain. A darkened screen showing tiled visuals. In the center of the screen is a bright magnified rectangle containing the contents of the VoiceOver cursor, the text Apple's Commitment to Accessibility. :end image description.

To tile visuals on the screen:

Press VO-F10.

The caption or braille panel moves to the top or bottom center of the screen, and the item in the VoiceOver cursor moves to the center of the screen. As you continue to navigate, the VoiceOver cursor stays in the center of the screen and you see the item you navigated to.

Muting sound effects
VoiceOver uses sound effects to let you know what's on the screen and to help you navigate. You can turn off VoiceOver sound effects without affecting the audio of other applications.

To turn off sounds:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Sound in the category table and then select the Mute Sounds checkbox.

If you're using VoiceOver gestures, avoid muting sound effects. Hearing the blank space sound effect is very useful in determining where items are located on the desktop.
Muting speech
VoiceOver uses speech to let you know what’s on the screen and to help you navigate. You can turn off VoiceOver speech without affecting the display in the caption or braille panels, or the audio of other applications.

To turn off spoken descriptions:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click Speech in the category table.
3. On the Voices pane, select the Mute Speech checkbox.

To turn on speech again, deselect the checkbox in VoiceOver Utility.

If you’re using VoiceOver gestures, you can mute VoiceOver speech and sound effects by double-tapping with three fingers on the trackpad. Repeat the gesture to hear speech and sound effects again.

Chapter 9. Customizing VoiceOver
This chapter explains how to customize your VoiceOver environment to best suit your needs. You’ll learn how to customize settings for voices, spoken details, braille displays, pronunciations, and more. You’ll also learn how to reset, export, and import your preferences, as well as use portable preferences.

Customizing voice settings
You can customize the voice, rate, pitch, volume, and intonation using a keyboard command or VoiceOver Utility.

Using a VoiceOver command:

1. To hear the first setting, press VO-Command-Right Arrow.

   If the last adjustment you made was to pitch, that’s the first setting you will hear; for example, "Pitch 50 percent."

2. Continue to press VO-Command-Right Arrow until you hear the setting you want to adjust.

3. To increase the setting’s value, press VO-Command-Up Arrow. To decrease the value, press
VO-Command-Down Arrow.

The new settings are applied only to the default voice.

**Using VoiceOver Utility:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Speech in the category table, and then click Voices.

3. Choose a name from the Default pop-up menu to choose one voice to speak everything in VoiceOver.

To display pop-up menus where you can choose different voices to speak specific items, such as status or attributes, click the disclosure triangle to the left of Default.

4. Set the rate, pitch, volume, and intonation of each voice in the fields to the right of the Voice pop-up menus.

You can type a number in the fields or use the steppers next to each field to adjust the values.

If you install Mac compatible voices in the Library/Speech/Voices folder of your home folder, they appear in the list of available voices. To make the voices available to other users who have access to your computer, install the voices in /Library/Speech/Voices.

If you’re using portable preferences on a guest computer at the time you change settings, the settings are saved to the portable preferences and not to the guest computer.


---

**Customizing the level of spoken detail**

By default, VoiceOver speaks a high level of detail to help new Mac and VoiceOver users. But you can choose a different default setting. You can also choose a verbosity setting for specific items, such as checkboxes or scroll areas, and change the order in which item details are spoken.

**To change verbosity levels:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click the Verbosity category and then click General.

For a description of the verbosity options, click the Help button (looks like a question mark) in the lower-right corner.
Customizing the layout of braille displays
If you have a refreshable braille display connected to or paired with your computer, you can customize its layout. For example, you can choose to use contracted braille or specify which status cells you want to use.

To set layout options:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.
2. Click Braille in the category table and then click Layout.

For a description of the options, click the Help button (looks like a question mark) in the lower-right corner.

Customizing the Web Item rotor
You can change the Web Item rotor to list only the types of items, such as links or tables, that you use most often when browsing webpages.

To customize the rotor:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.
2. Click Web and choose the items you want to include in the Web Item rotor from the pop-up menu.

For a description of the options, click the Help button (looks like a question mark) in the lower-right corner.

The types of items you include in the rotor determine the statistics VoiceOver speaks in the webpage summary.

Refer to "Chapter 6. Browsing the Internet: Browsing webpages."

Changing pronunciations in the Speech Dictionary
You can set the preferred pronunciation for words such as names or acronyms, and select word substitutions so that when certain text or symbols appear, a preferred word is substituted for the text or symbol. For example, when you're in a chat where symbols are used to convey emotion, hear "Wink Smiley" instead of "semicolon dash right parenthesis."

To add a pronunciation:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO–F8.
2. Click Speech in the category table, click Pronunciation, and then click the Add (+) button near the bottom of the window.

3. In the new row, type the text you want to replace with a substitution, press Tab, and then type the substitution.

4. Choose an application from the Application pop-up menu.

The menu displays only the applications that are open. To use the pronunciation in any application whenever it's open, leave "All applications" selected.

5. To have capitalization ignored, select the Ignore Case checkbox.

To edit a substitution:

- Double-click the field you want to edit and type new text or a new substitution.

- Choose a different setting from the Applications pop-up menu.

- Change the Ignore Case setting.

To remove a pronunciation:

Select the pronunciation and click the Remove (−) button near the bottom of the window.

You can assign a command for adding a pronunciation to a key on the numeric keypad or keyboard, or on a braille display. If you're using a Multi-Touch trackpad, you can assign the command to a VoiceOver gesture.

Creating custom labels

You can create or rename a label for many user interface elements, such as images, buttons, tables, and more, in applications and webpages. You can export your custom labels to a file to share with other users.

To create a label for an element:

1. Position the VoiceOver cursor on the element for which you want to create the label.

2. Press VO−/.

3. In the dialog that's displayed, enter the text for your label and press Enter.

When you create a custom label for an element, VoiceOver remembers pertinent information about the element and its location to associate with your label. If the element changes in a significant way, such as moving to a new location, VoiceOver may not recognize it as the same element.
Assigning VoiceOver commands to numpad and keyboard keys

If your computer has a numeric keypad, you can enable the NumPad Commander and assign VoiceOver commands to numpad keys, so you can enter the commands using only the numeric keypad. You can use the Keyboard Commander to assign VoiceOver commands to keyboard keys.

By default, the NumPad Commander has already assigned basic navigation and interaction commands to some keys. The Keyboard Commander has assigned scripts and shortcuts for opening applications to some keys. To use the default key assignments, just enable the Commanders. You can change the defaults or add your own.

To assign commands to keys:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click Commanders in the category table, click NumPad or Keyboard, and then in the NumPad or Keyboard pane, select the checkbox to enable the Commander.

3. Choose a modifier key.

Using a modifier key with numpad keys is optional. However, using a modifier key with keyboard keys is required. In the Keyboard Commander pane, select the left or right Option key as the modifier key.

4. Interact with the Commander table and navigate down the key column until you hear the
numpad or keyboard key you want to assign a command to.

5. Move to the Command column, open the pop-up menu of commands, and then use the arrow keys to navigate the available commands.

begin image description: A screen shot of the Keyboard Commander. The VoiceOver Utility window, divided vertically into two parts. A sidebar on the left lists categories, preceded by an icon, and an area on the right shows options for the currently selected category. Commanders is the current category in the sidebar and the Keyboard pane is selected on the right. At the top right of the Keyboard pane is the Enable Keyboard Commander checkbox, which is selected. To the right of that are the Use Left Option key and Right Option key radio buttons, with Right Option key selected. Below the checkbox and radio buttons is a table with two columns, from left to right: Keyboard Key, Command. The third row is selected and contains t in the Keyboard Key column and on the right is a pop-up menu of command categories for assigning a command to the t key. The command categories from top to bottom are: General, Information, Navigation, Text, Web, Find, Tables, Size and Position, Audio, Braille, Visuals, Hot spots, Jump, Custom Commands. To the right of each category name is an arrow for displaying the commands in each category. :end image description.

6. When you hear the command you want to assign to the current numpad or keyboard key, press Return to select it.

You can use the Custom Commands menu to assign scripts and Automator workflows to keys. For example, you could run a script (such as a Perl, Ruby, Python, or AppleScript script) when you press a specific key on the keyboard.

Reseting preferences
If you have changed VoiceOver settings, you can reset all or specific preferences to their default values.

IMPORTANT: It’s recommended you export your preferences before you reset them, to be able to use the export file as a backup of your preferences. If you’re using a portable preferences drive on your computer, eject the drive before you reset preferences; otherwise, the reset preferences will be synced to the portable preferences drive.

To reset preferences:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Choose File and then choose the reset command for the preferences you want to reset.

You can choose to reset basic, custom (such as hot spots or Keyboard Commander key assignments), or all preferences.
Exporting and importing preferences

You can export all or specific VoiceOver settings as a file to save or share.

You can import preference files from VoiceOver in Mac OS X 10.5 and later. If a preference existed in Mac OS X 10.5 or later but no longer exists in Mac OS X 10.6, the preference is not imported.

To export preferences:

1. In VoiceOver Utility, choose File > Export Preferences or press Shift-Command-E.
2. Type a name for the file and choose the folder in which you want to save it.
   To choose from more folders, click the disclosure triangle after the filename.
3. From the Export pop-up menu, choose the type of preferences you want to export.
4. Click Save.

   The default filename indicates the type of preferences exported and has a .voprefs extension. This file is not updated and will not reflect changes you make to preferences after exporting.

To import preferences:

In VoiceOver Utility, choose File > Import Preferences or press Shift-Command-I.

VoiceOver replaces the current preferences of that type with those in the file. If you're importing web spots or labels, VoiceOver merges them with your existing web spots or labels.

You can use portable preferences, stored on a removable storage device, to easily use your settings on other Mac computers and to keep an up-to-date copy of your current settings always available.

Refer to "Chapter 9. Customizing VoiceOver: Using portable preferences."

Using portable preferences

You can use portable preferences, stored on a removable storage device, to easily use your settings on other Mac computers and to keep an up-to-date copy of your current settings always available.

Set up the portable preferences drive

Do this set of steps once for each removable drive you want to use.
1. Insert the removable drive in your computer.

2. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8, and then choose File > Set Up Portable Preferences or click Set Up in the General category table.

3. Select a drive from the list of removable drives and click OK.

VoiceOver creates a VoiceOver folder on the drive.

**Use the portable preferences drive**

VoiceOver detects the portable preferences drive and asks if you want to use it. When you use the drive:

**In the computer where it was created:** changes you make to VoiceOver preferences until you eject the drive are automatically saved to the drive. For example, if you increase the speech rate, your change is instantly saved to the portable preferences drive.

**In another computer (as a guest):** uses the drive for VoiceOver preferences. Any changes you make to VoiceOver preferences until you eject the drive are automatically saved to the drive and not to the guest computer.

When you're done, eject the portable preferences drive using Finder, or click Stop in the General category table in VoiceOver Utility.

If you chose not to use the portable preferences drive when VoiceOver asked you, but later want to use it, click Start in the General category table in VoiceOver Utility.

If you chose to always use the portable preferences drive when VoiceOver asked you, but later want to use it only sometimes, delete the preferences file from the drive in Finder by pressing Command-Delete, and then set up the portable preferences drive again.

If you changed preferences while using the portable preferences drive on a guest computer, then the next time you use the drive in the computer where it was created, VoiceOver synchronizes preferences on the computer and the drive based on the most recent change to a preference.

You can export all or specific VoiceOver settings as a file to save or share. This file is not updated and will not reflect changes you make to preferences after exporting. You can import preference files from VoiceOver in Mac OS X 10.5 and later.

Refer to "Chapter 9. Customizing VoiceOver: Exporting and importing preferences."

---

**Chapter 10. Using Braille Displays**

This chapter provides information about using refreshable braille displays, both plug in and
Bluetooth, with VoiceOver. This chapter also includes a list of the many types of braille displays VoiceOver supports.

About refreshable braille displays
If you have a supported braille display connected to (or in the case of a Bluetooth display, paired with) your computer, VoiceOver automatically detects it and sends it information about what is displayed on the screen. You can connect multiple braille displays to your computer and each display will mirror the same content at the same time, which can be useful in a classroom setting.

By default, VoiceOver displays uncontracted braille. You can set a preference to use contracted braille, in which case VoiceOver dynamically changes the display under the cursor from contracted to uncontracted braille, so that you can read and edit more easily, and then changes back to contracted braille when you move the cursor.

A braille display typically contains more than just the contents of the VoiceOver cursor. It describes the contents of the entire line on which the VoiceOver cursor is focused, including items to the left and right of the VoiceOver cursor. For example, when the VoiceOver cursor is focused on an item in a window, the braille device displays items like icons, checkboxes, and pop-up menus, as well as text that is to the left and right of the item in the VoiceOver cursor. This collection of items—the VoiceOver cursor and the items to its left and right on the same horizontal line—make up a "line" of braille.

When you interact with an item in the VoiceOver cursor to get more detail about it, the braille description changes to provide more detail as well. For example, if you move the VoiceOver cursor onto a toolbar, VoiceOver describes only the toolbar on the braille display, because toolbars stretch the entire width of a window. When you interact with the toolbar, the braille display describes each item in the toolbar from left to right.

VoiceOver raises dots 7 and 8 to indicate the position of the VoiceOver cursor, to help you locate it within the line of braille. (You can turn off this feature in VoiceOver Utility). Similarly, when you're editing or selecting text, the text selection is represented by dots 7 and 8. VoiceOver also indicates the position of the text selection cursor, called the "I-beam," by flashing dot 8 of the braille cell preceding the text selection cursor and dot 7 of the braille cell trailing the text selection cursor.

VoiceOver provides additional information about what's on the screen using three status cells. Each status cell provides a designated type of information. You can set preferences for the number of status cells you want to use and their location on the braille display. For example, you can choose to use the cell that shows text status and set its location to be on the left of your display.

VoiceOver detects the type of braille display connected to your computer and sets default preferences appropriate for your display. Use VoiceOver Utility to assign VoiceOver commands to keys on your braille display. You can use the braille display while listening to VoiceOver speak, or you can mute the speech. If your braille display has a Perkins-style keyboard, you can type on it.
Pairing a Bluetooth braille display

Before you can use a supported Bluetooth braille display with VoiceOver, you must pair your braille display. You can pair only one Bluetooth braille display at a time. You pair the display only once; it remains paired until you remove it from the pairing. After your braille display is paired, VoiceOver detects it whenever it’s turned on and within range; if it’s your primary braille display, you can then use it.

To pair a Bluetooth braille display with VoiceOver:

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2. Click the Braille category, click Displays, and then click the Add (+) button.
3. Select your Bluetooth braille display in the list.
   VoiceOver filters the devices it detects to list only the Bluetooth braille displays that are within range of your computer and that appear to match a VoiceOver braille display driver.
4. Click Select.
   You may be asked to provide a pairing passcode (such as 0000 or 1234, two common default codes). Check the documentation that came with your braille display for the passcode.

If the Bluetooth braille display you selected in the list doesn't work with VoiceOver, it's likely that its driver doesn't match a VoiceOver driver. Try pairing a different Bluetooth braille display.

If your Bluetooth braille display isn’t listed, make sure you have set the display to be discoverable. For more information, check the documentation that came with your braille display.

About panning on a braille display

Sometimes a line of braille is too wide to fit on the braille display. You can “pan” the line by pressing the left and right buttons on the display to move through the line. Each left or right pan moves according to the number of cells (including status cells) your display contains.

When you move the VoiceOver cursor using the VoiceOver keys, the braille display automatically pans when necessary to follow it, even wrapping to the previous or next line.
Using router keys on a braille display

Many braille displays have router keys above the braille cells that you can use to move the cursor. Generally, you press the router key above a particular item in the line of braille to move the VoiceOver cursor or selection to that item.

Pressing a router key over a control moves the VoiceOver cursor to that control if the VoiceOver cursor is not already there. If the VoiceOver cursor is already on that control, pressing the router key performs the control’s default action. For example, to click a button, you could press the router key to move the VoiceOver cursor to the button and then press the router key again to click the button. You would not have to touch the computer’s keyboard at all. Similarly, when you’re reading or navigating text and you press a router key, the VoiceOver cursor moves to that location in text.

You can also press the router key above a status cell to display an expanded braille description of each dot in the cell. To exit the description, press any other router key.

Using status cells on a braille display

The content of the line on the screen where the VoiceOver cursor is focused appears in the cells of the braille display. VoiceOver uses status cells to provide additional information about the line, such as the text attributes.

If your braille display has dedicated status cells, VoiceOver uses those cells to show the additional information, based on the preferences you set in VoiceOver Utility. Otherwise, VoiceOver uses the first one to three cells on the left or right of the display, based on your preferences. VoiceOver reserves another cell, which it leaves blank, as a separator between the status cells and the other cells.

Here are ways to use status cells:

• If you set the preference to show the general display status, it shows status about VoiceOver, the braille display, and the system.

For example, dots 1 and 2 indicate unread and read announcements, and dots 7 and 8 indicate you can pan the display left or right.

• If you set the preference to show the text style status cell, it shows common text styles, such as bold or italic font.

For example, dots 1 and 2 indicate bold and italic text respectively, and dot 4 indicates the selected text is misspelled.

• If you set the preference to show the extended text style status cell, it shows less common text styles.

For example, dots 1 and 2 indicate text is superscript or subscript respectively, and dot 5
• Press the router key above a status cell to display an expanded braille description of each dot in the cell. To exit the description, press any other router key.

If you didn't set any status cell preferences, status is not shown, and all of the reading cells are used to show the content of the current line.

**Reviewing announcements on a braille display**
VoiceOver sends announcements about events that are not represented visually on the screen to the braille display. For example, if an application running in the background needs attention or if a new window appears onscreen, VoiceOver sends an announcement to the braille display.

VoiceOver stores up to 30 announcements in the history; the most recent announcement is the first one. If you set a preference to use the status cell that shows general display status, you can review announcements.

Here are ways to review announcements:

• On the status cell that shows general display status, dot 1 indicates whether there are new unread announcements. Dot 2 indicates whether the current announcement has already been read.

• If you mapped a key to the Announcement History command, press that key to show the most recent announcement in the reading cells. Use the Up Arrow and Down Arrow keys to cycle through announcements.

• To cycle through the announcement history, press the Up Arrow key to move backward to the oldest announcement, and press the Down Arrow key to move forward to the most recent announcement.

When you're done reviewing announcements, press any router key above the announcement to redisplay the current line.

**Assigning braille display keys to VoiceOver commands**
VoiceOver detects whether your braille display provides input keys and assigns common VoiceOver commands to the keys. In this way, it helps you work more efficiently by using the computer keyboard less. For example, VoiceOver might assign the Down command to the D3 key; when you press that key on your braille display, the VoiceOver cursor moves down one line on the screen. You can change the default assignments and add your own.

**To assign input keys to commands:**
1. With your braille display connected to or paired with your computer and with VoiceOver on, open VoiceOver Utility by pressing VO-F8.

2. Click Braille in the category table, click Displays, select the braille display you want to assign commands for, and then click Assign Commands.

3. Choose the VoiceOver command you want to assign to input keys.

   - For an existing assignment, choose a command from the pop-up menus in a row.

   - For a new assignment, click the Add (+) button to add a row to the list, and then choose a command from the pop-up menus in the row.

4. Press Command-B to save the assignment.

   After you press Command-B, you’ll have about five seconds before VoiceOver saves the assignment. A sound effect counts down the seconds.

### Supported braille displays

Mac OS X supports a wide range of USB and Bluetooth braille displays.

**NOTE:** The table indicates displays that are Bluetooth only, or are USB and Bluetooth. If neither label appears, the display is USB only.

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alva</td>
<td>BC640 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BC680 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>EasyLink 12 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>544 Satellite</td>
</tr>
<tr>
<td></td>
<td>544 Satellite Traveller</td>
</tr>
<tr>
<td></td>
<td>570 Satellite Pro</td>
</tr>
<tr>
<td></td>
<td>584 Satellite Pro</td>
</tr>
<tr>
<td>American Printing House for the Blind (APH)</td>
<td>Refreshabraille 18 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Baum</td>
<td>Conny 12 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Note: VoiceOver identifies this display as HumanWare BrailleConnect 12.</td>
</tr>
<tr>
<td></td>
<td>PocketVario 24</td>
</tr>
<tr>
<td></td>
<td>SuperVario 32</td>
</tr>
<tr>
<td></td>
<td>SuperVario 40</td>
</tr>
<tr>
<td></td>
<td>SuperVario 64</td>
</tr>
<tr>
<td></td>
<td>SuperVario 80</td>
</tr>
<tr>
<td></td>
<td>VarioConnect 24</td>
</tr>
<tr>
<td>Humanware</td>
<td>BrailleConnect 12 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 24 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleNote mPower BT 18 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleNote mPower BT 32 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 24 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 64 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 80 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Nippon Telesoft</td>
<td>Seika Version 3</td>
</tr>
<tr>
<td>Papenmeier</td>
<td>Braillex Trio (USB and Bluetooth)</td>
</tr>
<tr>
<td>HandyTech</td>
<td>Braille Star 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Braille Star 8</td>
</tr>
<tr>
<td></td>
<td>Braille Wave (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Braillino (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Easy Braille (USB and Bluetooth)</td>
</tr>
<tr>
<td>HIMS</td>
<td>BrailleSense</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 20</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 32</td>
</tr>
<tr>
<td>HIMS/GW Micro</td>
<td>BrailleSense (Bluetooth, requiring a Bluetooth module)</td>
</tr>
<tr>
<td></td>
<td>BrailleSense Plus (Bluetooth, not requiring a Bluetooth module)</td>
</tr>
<tr>
<td>Humanware</td>
<td>BrailleConnect 12 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 24 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Eurobraille</td>
<td>Esys 12 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Esys 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Freedom Scientific</td>
<td>Focus 40</td>
</tr>
<tr>
<td></td>
<td>Focus 80</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 20</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 40</td>
</tr>
<tr>
<td></td>
<td>PAC Mate BX420 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate BX440 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate QX420 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate QX440 (display only)</td>
</tr>
<tr>
<td>GW Micro</td>
<td>BrailleSense</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 20</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 32</td>
</tr>
<tr>
<td>HIMS/GW Micro</td>
<td>BrailleSense (Bluetooth, requiring a Bluetooth module)</td>
</tr>
<tr>
<td></td>
<td>BrailleSense Plus (Bluetooth, not requiring a Bluetooth module)</td>
</tr>
<tr>
<td>Eurobraille</td>
<td>Esys 12 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Esys 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Freedom Scientific</td>
<td>Focus 40</td>
</tr>
<tr>
<td></td>
<td>Focus 80</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 20</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 40</td>
</tr>
<tr>
<td>Eurobraille</td>
<td>Esys 12 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Esys 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Freedom Scientific</td>
<td>Focus 40</td>
</tr>
<tr>
<td></td>
<td>Focus 80</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 20</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Model</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alva</td>
<td>BC640 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BC680 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Freedom Scientific</td>
<td>Focus 12 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Focus 80 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 20 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate BX420 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate BX440 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate QX420 (display only)</td>
</tr>
<tr>
<td></td>
<td>PAC Mate QX440 (display only)</td>
</tr>
<tr>
<td>GW Micro</td>
<td>BrailleSense</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 20 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td>HandyTech</td>
<td>Braille Star 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Braille Star 8 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Braille Wave (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Braillino (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Easy Braille (USB and Bluetooth)</td>
</tr>
<tr>
<td>HIMS</td>
<td>BrailleSense</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 20 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>SyncBraille 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td>HIMS/GW Micro</td>
<td>BrailleSense (Bluetooth, requiring a Bluetooth module)</td>
</tr>
<tr>
<td></td>
<td>BrailleSense Plus (Bluetooth, not requiring a Bluetooth module)</td>
</tr>
<tr>
<td>Humanware</td>
<td>BrailleConnect 12 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 24 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleConnect 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleNote mPower BT 18 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>BrailleNote mPower BT 32 (Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 24 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 32 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 40 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 64 (USB and Bluetooth)</td>
</tr>
<tr>
<td></td>
<td>Brailliant 80 (USB and Bluetooth)</td>
</tr>
<tr>
<td>Nippon Telesoft</td>
<td>Seika Version 3</td>
</tr>
<tr>
<td>Papenmeier</td>
<td>Braillex Trio (USB and Bluetooth)</td>
</tr>
</tbody>
</table>

**Chapter 11. Using VoiceOver Gestures**

This chapter explains how you can control your computer using VoiceOver gestures on a Multi-Touch trackpad.
About VoiceOver gestures
If you have a Multi-Touch trackpad and VoiceOver is turned on, you can use gestures to navigate and interact with items on the screen, and enter VoiceOver commands.

To use VoiceOver gestures, you enable the Trackpad Commander by holding down the Control and Option keys (called the “VO keys”) while rotating two fingers clockwise on the trackpad, or by selecting the option in VoiceOver Utility. Once enabled, you can use a set of standard VoiceOver gestures, and you can customize other gestures by assigning VoiceOver commands to them.

VoiceOver gestures involve using one or more fingers to drag, tap, flick, or rotate on the trackpad. You can use different techniques for a gesture. For example, you can tap using two fingers from one hand, or one finger from each hand. Try different techniques to discover which one works best for you. You can use keyboard help to practice standard and customized gestures and learn what they do.

VoiceOver speaks the items in the VoiceOver cursor as you move the cursor, and plays a sound effect whenever it encounters a blank space on the screen. This information helps you gain a sense of the actual location of items on the screen as you navigate.

When you touch the trackpad, it’s as if you’re touching a portion of the screen. The trackpad represents the window or area on the screen where the VoiceOver cursor is located. When you drag a finger on the trackpad, you move the VoiceOver cursor only in that window or area. For example, if the cursor is in the Mail toolbar, the trackpad represents the Mail toolbar. When you drag your finger on the trackpad, you move the VoiceOver cursor in the Mail toolbar. Because the trackpad represents only a specific area and not the entire screen, you can’t stray to other areas or applications by accident.

To enhance collaboration with sighted users, VoiceOver makes the area of the screen you’re working in more visible by dimming the rest of the screen. You can adjust the transparency of this effect using the Touch pane in VoiceOver utility. Other collaboration features, such as the caption or braille panels, can also be used at the same time as VoiceOver gestures.

To disable the Trackpad Commander and stop using VoiceOver gestures, hold down the Control and Option keys while rotating two fingers counterclockwise on the trackpad, or select the option in VoiceOver Utility.

Using VoiceOver gestures
If you’re using a Multi–Touch trackpad, you can enable the Trackpad Commander to start using
standard VoiceOver gestures to navigate and interact with items on the screen.

**NOTE:** When you're using VoiceOver gestures, you can't use the mouse button on the trackpad, unless the mouse button is used with a modifier key, as in Control-click.

**To enable the Trackpad Commander:**

Hold down the Control and Option keys (the "VO keys") and rotate two fingers clockwise anywhere on the trackpad.

**To use VoiceOver gestures:**

- VoiceOver includes standard gestures for navigating and interacting with items on the screen. You can't change these gestures.

Refer to "Appendix A. Commands and Gestures: VoiceOver standard gestures."

- You can customize other gestures by assigning VoiceOver commands to them.

Refer to "Chapter 11. Using VoiceOver Gestures: Assigning VoiceOver commands to gestures."

- You can use a rotor to navigate text areas, windows, dialogs, and webpages, and adjust controls such as sliders, steppers, and splitters.


Here are some tips to keep in mind as you use VoiceOver gestures:

- If you don't know where you are on the screen, tap three times. VoiceOver tells you what is in the VoiceOver cursor.

- When you're dragging a finger and you hear something you want to select, keep your finger on the trackpad and use a second finger to tap the trackpad. This gesture is called a "split-tap."

**To disable the Trackpad Commander:**

Hold down the Control and Option keys (the "VO keys") and rotate two fingers counterclockwise anywhere on the trackpad.

You can use both VoiceOver gestures and keyboard shortcuts to enter VoiceOver commands.

**Assigning VoiceOver commands to gestures**

If you have enabled the Trackpad Commander to use VoiceOver gestures, you can assign
VoiceOver commands to some gestures.

**NOTE:** VoiceOver includes a set of standard VoiceOver gestures, which you can't change.

Refer to "Appendix A. Commands and Gestures: VoiceOver standard gestures."

**To assign commands to gestures:**

1. When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.

2. Click the Commanders category, click Trackpad, and make sure the Enable Trackpad Commander checkbox is selected.

3. Click Assign Commands.

4. From the pop-up menu, choose the modifier key to use with gestures. By default, Command is used.

Unlike standard VoiceOver gestures, you must hold down a modifier key to use customized gestures.

5. Interact with the Trackpad Gesture Commands table and navigate down the gesture column until you hear the gesture you want to assign a command to.

Refer to "Chapter 2. Learning VoiceOver Basics: Interacting with content areas."

6. Move to the Command column, open the pop-up menu of commands, and then use the arrow keys to navigate the available commands.

7. When you hear the command you want to assign to the current gesture, press Return to select it.

8. When you're finished assigning commands, click Done.

You can use the Custom Commands menu to assign scripts and Automator workflows to
gestures. For example, you could run a script (such as a Perl, Ruby, Python, or AppleScript script) when you use the gesture Command-Two-finger Double-tap.

Using rotor settings with gestures

If you're using VoiceOver gestures, the rotor is like a virtual dial you turn to access various ways to navigate, based on the current context. For example, when you're browsing a webpage, use settings such as tables, web spots, or images. In other contexts, use settings such as navigation, words, characters, or adjust.

To use rotor settings:

1. Rotate two fingers on the trackpad until you hear the setting you want to use.

   As you "turn" the rotor, VoiceOver speaks each setting and plays a clicking sound. If you miss a setting, keep turning the rotor until you hear the setting again.

2. Flick up or down on the trackpad to navigate to the previous or next instance of an item, based on the current setting.

   For example, if the current setting is Word, then when you flick down on the trackpad, the VoiceOver cursor moves to the next word. Keep flicking down to move forward word by word. If you repeatedly flick up on the trackpad, the VoiceOver cursor moves backwards word by word.

Here are the settings you can use:

**Web settings:** Headers, Images, Frames, Tables, Non-Visited Links, Visited Links, Web Spots, Form Controls, Auto Web Spots, Links

**Other settings:** Character, Word, Navigation, Adjust

The Character and Word settings are most useful when interacting with a text area, to read the text by character or by word. Use the Adjust setting to increase or decrease the values in a slider, stepper, splitter, or other similar control.

The Navigation setting navigates text line by line. When you're interacting with a text area, VoiceOver begins speaking the first line at the point where the cursor was located when you first flicked up or down; it speaks each subsequent line in its entirety.

When you use the Navigation setting in a window or dialog, VoiceOver might not speak all of the items on a line, depending on how the items are arranged. You may need to flick left or right and then flick up or down again to hear other items.

The current web navigation mode affects how you navigate webpages using the rotor. In DOM mode, flicking up or down on the trackpad moves to the previous or next instance of the item that matches the current rotor setting. For example, if the rotor is set to headers, flicking up or down moves to the previous or next header. In grouping related items mode, flicking up or down moves to the previous or next group of related items. You can assign the "Toggle Web Navigation DOM or Group" command to a gesture using the Trackpad Commander, to easily switch modes to suit your needs.
Appendix A. Commands and Gestures

This appendix lists VoiceOver commands and gestures, organized into categories.

General commands
Use these commands to turn VoiceOver on and off, get help, change basic settings, and enable and disable Commanders.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn VoiceOver on or off</td>
<td>Command-F5</td>
</tr>
<tr>
<td>Lock and unlock the VO (Control and Option) keys</td>
<td>VO-;</td>
</tr>
<tr>
<td>Open VoiceOver Utility</td>
<td>VO-F8</td>
</tr>
<tr>
<td>Open the VoiceOver Help menu</td>
<td>VO-H</td>
</tr>
<tr>
<td>Open the VoiceOver Quick Start</td>
<td>VO-Command-F8</td>
</tr>
<tr>
<td>Open VoiceOver online help</td>
<td>VO-?</td>
</tr>
<tr>
<td>Start keyboard help</td>
<td>VO-K</td>
</tr>
<tr>
<td>Hear a description of the item in the VoiceOver cursor</td>
<td>VO-Shift-N</td>
</tr>
<tr>
<td>Open the Commands menu</td>
<td>VO-H-H</td>
</tr>
<tr>
<td>Open the Find menu</td>
<td>VO-Shift-F</td>
</tr>
<tr>
<td>Close a menu or rotor, stop an action, or exit a mode</td>
<td>Escape</td>
</tr>
<tr>
<td>Tell VoiceOver to ignore the next key combination you press</td>
<td>VO-Tab</td>
</tr>
<tr>
<td>Open the verbosity rotor</td>
<td>VO-V</td>
</tr>
<tr>
<td>Then press the Left Arrow or Right Arrow key to choose the setting. Use the Up Arrow and Down Arrow keys to change the level for the setting.</td>
<td></td>
</tr>
<tr>
<td>Magnify the item in the VoiceOver cursor</td>
<td>VO-}</td>
</tr>
<tr>
<td>Shrink the item in the VoiceOver cursor</td>
<td>VO-{</td>
</tr>
<tr>
<td>Temporarily hide or show the VoiceOver cursor and the caption or braille panels</td>
<td>VO-F11</td>
</tr>
<tr>
<td>Action</td>
<td>Command</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Turn VoiceOver on or off</td>
<td>Command-F5</td>
</tr>
<tr>
<td>Lock and unlock the VO (Control and Option) keys</td>
<td>VO-;</td>
</tr>
<tr>
<td>Open VoiceOver Utility</td>
<td>VO-F8</td>
</tr>
<tr>
<td>Open the VoiceOver Help menu</td>
<td>VO-H</td>
</tr>
<tr>
<td>Open the VoiceOver Quick Start</td>
<td>VO-Command-F8</td>
</tr>
<tr>
<td>Open VoiceOver online help</td>
<td>VO-?</td>
</tr>
<tr>
<td>Start keyboard help</td>
<td>VO-K</td>
</tr>
<tr>
<td>Hear a description of the item in the VoiceOver cursor</td>
<td>VO-Shift-N</td>
</tr>
<tr>
<td>Open the Commands menu</td>
<td>VO-H-H</td>
</tr>
<tr>
<td>Open the Find menu</td>
<td>VO-Shift-F</td>
</tr>
<tr>
<td>Close a menu or rotor, stop an action, or exit a mode</td>
<td>Escape</td>
</tr>
<tr>
<td>Tell VoiceOver to ignore the next key combination you press</td>
<td>VO-Tab</td>
</tr>
<tr>
<td>Open the verbosity rotor</td>
<td>VO-V</td>
</tr>
<tr>
<td>Then press the Left Arrow or Right Arrow key to choose the setting.</td>
<td>Use the Up Arrow and Down Arrow keys to change the level for the setting.</td>
</tr>
<tr>
<td>Magnify the item in the VoiceOver cursor</td>
<td>VO-}</td>
</tr>
<tr>
<td>Shrink the item in the VoiceOver cursor</td>
<td>VO-{</td>
</tr>
<tr>
<td>Temporarily hide or show the VoiceOver cursor and the caption or braille panels</td>
<td>VO-F11</td>
</tr>
<tr>
<td>Hide or show the caption panel only</td>
<td>VO-Command-F10</td>
</tr>
<tr>
<td>Resize or move the caption panel</td>
<td>VO-Shift-F10</td>
</tr>
<tr>
<td>Press again to cycle through these actions. Then use the arrow keys to resize the panel or move it. Press the Shift key with the arrow keys to move in smaller increments.</td>
<td></td>
</tr>
<tr>
<td>Hide or show the braille panel only</td>
<td>VO-Command-F9</td>
</tr>
<tr>
<td>Resize or move the braille panel</td>
<td>VO-Shift-F9</td>
</tr>
<tr>
<td>Press again to cycle through these actions. Then use the arrow keys to resize the panel or move it. Press the Shift key with the arrow keys to move in smaller increments.</td>
<td></td>
</tr>
<tr>
<td>Tile visuals (dim the screen, highlight the caption or braille panel, and show the item in the VoiceOver cursor in the center of the screen).</td>
<td>VO-F10</td>
</tr>
<tr>
<td>Press again to return to the normal view.</td>
<td></td>
</tr>
<tr>
<td>Enable or disable the NumPad Commander</td>
<td>VO-Clear</td>
</tr>
<tr>
<td>Enable or disable the Keyboard Commander</td>
<td>VO-Shift-K</td>
</tr>
<tr>
<td>Enable or disable the Trackpad Commander</td>
<td>Press the VO (Control-Option) keys and rotate two fingers on the trackpad clockwise (enable) or counterclockwise (disable)</td>
</tr>
<tr>
<td>Turn the screen black (screen curtain)</td>
<td>VO-Shift-F11</td>
</tr>
<tr>
<td>Cycle through speech settings (rate, pitch, volume, intonation, voice)</td>
<td>VO-Command-Right Arrow or Left Arrow</td>
</tr>
<tr>
<td>Change the current speech setting (rate, pitch, volume, intonation, voice)</td>
<td>VO-Command-Up Arrow or Down Arrow</td>
</tr>
<tr>
<td>Press and release mouse button</td>
<td>VO-Shift-Space bar</td>
</tr>
</tbody>
</table>

**Interaction commands**

Use these commands to interact with items on the screen.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.
<table>
<thead>
<tr>
<th>Select a menu or list item</th>
<th>VO-Return</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select multiple items</td>
<td>VO-Command-Space bar</td>
</tr>
<tr>
<td></td>
<td>Turn off cursor tracking to use this command.</td>
</tr>
<tr>
<td>Perform a sticky mouse down or mouse up (for use when dragging an item from one location to drop in another location)</td>
<td>VO-Command-Shift-Space bar</td>
</tr>
<tr>
<td>Click the item under the mouse cursor</td>
<td>VO-Shift-Space bar</td>
</tr>
<tr>
<td></td>
<td>Press once for a single mouse click and two times to double-click.</td>
</tr>
<tr>
<td>Open or close a disclosure triangle</td>
<td>VO-\</td>
</tr>
<tr>
<td>Read a row in a table</td>
<td>VO-R</td>
</tr>
<tr>
<td>Read a column in a table</td>
<td>VO-C-C</td>
</tr>
<tr>
<td>Read the column header in a table</td>
<td>VO-C</td>
</tr>
<tr>
<td>Read row and column numbers in a table</td>
<td>VO-Shift-T</td>
</tr>
<tr>
<td>Sort a column in a table</td>
<td>VO-</td>
</tr>
<tr>
<td>Interact with scroll bars</td>
<td>VO-Shift-S</td>
</tr>
<tr>
<td></td>
<td>Then use the arrow keys to scroll up or down or side to side. Use Page Up and Page Down to scroll vertically one page at a time. Use Shift–Page Up and Shift–Page Down to scroll horizontally one page at a time.</td>
</tr>
<tr>
<td>Resize a window or an object</td>
<td>VO-~</td>
</tr>
<tr>
<td>Move a window or an object</td>
<td>VO-'</td>
</tr>
<tr>
<td></td>
<td>Then use the arrow keys to move the window. Use Shift with the arrow keys to move in smaller increments.</td>
</tr>
<tr>
<td>Stop scrolling or resizing</td>
<td>Escape</td>
</tr>
</tbody>
</table>

**Navigation commands**

Use these commands to move around the screen, move inside windows and webpages, and control cursor tracking.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move up</td>
<td>VO-Up Arrow</td>
</tr>
<tr>
<td>Move down</td>
<td>VO-Down Arrow</td>
</tr>
<tr>
<td>Move to previous</td>
<td>VO-Left Arrow</td>
</tr>
<tr>
<td>Move to next</td>
<td>VO-Right Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Command</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Move to the top of the visible area (such as a window or text area)</td>
<td>VO-Home</td>
</tr>
<tr>
<td>where the VoiceOver cursor is located</td>
<td>On some keyboards, press VO–Fn–Left Arrow.</td>
</tr>
<tr>
<td>Move to the bottom of the visible area (such as a window or text area)</td>
<td>VO-End</td>
</tr>
<tr>
<td>where the VoiceOver cursor is located</td>
<td>On some keyboards, press VO–Fn–Right Arrow.</td>
</tr>
<tr>
<td>Move to the top of the area (such as a window or text area) where</td>
<td>VO-Shift-Home</td>
</tr>
<tr>
<td>the VoiceOver cursor is located, scrolling if necessary</td>
<td>On some keyboards, press VO–Shift–Fn–Left Arrow.</td>
</tr>
<tr>
<td>Move to the bottom of the area (such as a window or text area) where</td>
<td>VO-Shift-End</td>
</tr>
<tr>
<td>the VoiceOver cursor is located, scrolling if necessary</td>
<td>On some keyboards, press VO–Shift–Fn–Right Arrow.</td>
</tr>
<tr>
<td>Move to the top of a window, the first item in the Dock, or the first</td>
<td>VO-Command-Home</td>
</tr>
<tr>
<td>item on your desktop, depending on your location</td>
<td>On some keyboards, press VO–Command–Fn–Left Arrow.</td>
</tr>
<tr>
<td>Move to the lower–right corner of a window, the last item in the Dock,</td>
<td>VO-Command-End</td>
</tr>
<tr>
<td>or the last item on your desktop, depending on your location</td>
<td>On some keyboards, press VO–Command–Fn–Right Arrow.</td>
</tr>
<tr>
<td>Move to the front the window where the VoiceOver cursor is located</td>
<td>VO-Shift-F2</td>
</tr>
<tr>
<td>and make it active</td>
<td></td>
</tr>
<tr>
<td>Close the window where the VoiceOver cursor is located</td>
<td>VO-Command–F2</td>
</tr>
<tr>
<td>Open the Item Chooser</td>
<td>VO-I</td>
</tr>
<tr>
<td>Move to the Dock</td>
<td>VO-D</td>
</tr>
<tr>
<td>Move to the desktop</td>
<td>VO-Shift-D</td>
</tr>
<tr>
<td>Move to the menu bar</td>
<td>VO-M</td>
</tr>
<tr>
<td>Move to the first status menu in the menu bar</td>
<td>VO-M–M</td>
</tr>
<tr>
<td>Open the Spotlight menu</td>
<td>VO-M–M–M</td>
</tr>
<tr>
<td>Open a shortcut menu</td>
<td>VO-Shift–M</td>
</tr>
<tr>
<td>Jump to a linked item (for example, from a Mail message in the Inbox</td>
<td>VO-J</td>
</tr>
<tr>
<td>to its message text)</td>
<td></td>
</tr>
<tr>
<td>Temporarily disable or enable the cursor tracking options you selected</td>
<td>VO-Shift–F3</td>
</tr>
<tr>
<td>in VoiceOver Utility</td>
<td></td>
</tr>
<tr>
<td>The command doesn't change the settings in VoiceOver Utility</td>
<td></td>
</tr>
<tr>
<td>Move VoiceOver cursor to keyboard focus</td>
<td>VO-Shift–F4</td>
</tr>
<tr>
<td>Move keyboard focus to VoiceOver cursor</td>
<td>VO-Command–F4</td>
</tr>
<tr>
<td>Action</td>
<td>Command</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Move VoiceOver cursor to mouse cursor</td>
<td>VO-Shift-F5</td>
</tr>
<tr>
<td>Move mouse cursor to VoiceOver cursor</td>
<td>VO-Command-F5</td>
</tr>
<tr>
<td>Jump command (used with the next four commands)</td>
<td>VO-Shift-J</td>
</tr>
<tr>
<td>Jump to the edge of an area</td>
<td>VO-Shift-arrow keys</td>
</tr>
<tr>
<td>Jump to the visible edge of an area</td>
<td>VO-arrow keys</td>
</tr>
<tr>
<td>Jump to the area that precedes a horizontal or vertical splitter</td>
<td>VO-[</td>
</tr>
<tr>
<td>Jump to the area that follows a horizontal or vertical splitter</td>
<td>VO-]</td>
</tr>
<tr>
<td>Find text</td>
<td>VO-F</td>
</tr>
<tr>
<td>While finding text, cycle through search item history</td>
<td>VO-Up Arrow or Down Arrow</td>
</tr>
<tr>
<td>Navigate in given direction, wrapping when necessary</td>
<td>VO-Command-Shift-arrow keys</td>
</tr>
<tr>
<td>Set or remove a hot spot</td>
<td>VO-Shift-[number key]</td>
</tr>
<tr>
<td>Open the Hot Spot Chooser</td>
<td>VO-[number key]-[number key]</td>
</tr>
<tr>
<td>Jump to a hot spot</td>
<td>VO-[number key]</td>
</tr>
<tr>
<td>Hear a description of a hot spot</td>
<td>VO-Command-[number key]</td>
</tr>
<tr>
<td>Monitor a hot spot</td>
<td>VO-Command-Shift-[number key]</td>
</tr>
<tr>
<td>Jump back to a parent folder</td>
<td>VO-Command-\</td>
</tr>
</tbody>
</table>

**Orientation commands**

Use these commands to hear where the cursors are located and what is open on the screen.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.
<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Describe the item under the mouse cursor</td>
<td>VO-F5</td>
</tr>
<tr>
<td>Describe the location of the mouse in x, y coordinates (from upper–left corner of screen)</td>
<td>VO-F5-F5</td>
</tr>
<tr>
<td>Describe the location of the mouse (from upper–left corner of window)</td>
<td>VO-F5-F5-F5</td>
</tr>
<tr>
<td>Describe the selected item</td>
<td>VO-F6</td>
</tr>
<tr>
<td>Read everything in the VoiceOver cursor</td>
<td>VO-A</td>
</tr>
<tr>
<td>Read everything visible in the window or the Dock, or on your desktop, depending on your location</td>
<td>VO-Shift-W</td>
</tr>
<tr>
<td>Repeat the last spoken phrase</td>
<td>VO-Z</td>
</tr>
<tr>
<td>Copy the last spoken phrase to the Clipboard (also called the &quot;Pasteboard&quot;)</td>
<td>VO-Shift-C</td>
</tr>
<tr>
<td>Save the last spoken phrase and the crash log to a file on the desktop for troubleshooting</td>
<td>VO-Shift-Z</td>
</tr>
</tbody>
</table>

**Search commands**

Use these commands to search for text attributes, graphics, controls, and other items in text documents and webpages.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.
Text commands
Use these commands to read and edit text and tables. Before you can use most of these commands, you must interact with text in a text area.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read all text from the VoiceOver cursor to the end of the text</td>
<td>VO-A</td>
</tr>
<tr>
<td>Select all text in the VoiceOver cursor</td>
<td>VO-Shift-A</td>
</tr>
<tr>
<td>Start and stop text selection in a text field (text selection tracking must be on)</td>
<td>VO-Return</td>
</tr>
<tr>
<td>Speak text attributes</td>
<td>VO-T</td>
</tr>
<tr>
<td>Add a hot spot in text</td>
<td>VO-Shift-1</td>
</tr>
<tr>
<td>Jump to a hot spot in text</td>
<td>VO-1</td>
</tr>
<tr>
<td>Read paragraph in VoiceOver cursor</td>
<td>VO-P</td>
</tr>
<tr>
<td>Read next paragraph</td>
<td>VO-Shift-Page Down</td>
</tr>
<tr>
<td>Command Description</td>
<td>VO-Key sequence(s)</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Read previous paragraph</td>
<td>VO-Shift-Page Up</td>
</tr>
<tr>
<td>Read sentence in VoiceOver cursor</td>
<td>VO-S</td>
</tr>
<tr>
<td>Read next sentence</td>
<td>VO-Command-Page Down</td>
</tr>
<tr>
<td>Read previous sentence</td>
<td>VO-Command-Page Up</td>
</tr>
<tr>
<td>Read line in VoiceOver cursor</td>
<td>VO-L</td>
</tr>
<tr>
<td>Read next line</td>
<td>VO-Down Arrow</td>
</tr>
<tr>
<td>Read previous line</td>
<td>VO-Up Arrow</td>
</tr>
<tr>
<td>Read word in VoiceOver cursor</td>
<td>VO-W</td>
</tr>
<tr>
<td></td>
<td>Press twice to hear the word spelled; press a third time to hear the word spelled phonetically.</td>
</tr>
<tr>
<td>Read next word</td>
<td>VO-Right Arrow</td>
</tr>
<tr>
<td>Read previous word</td>
<td>VO-Left Arrow</td>
</tr>
<tr>
<td>Read character in VoiceOver cursor</td>
<td>VO-C</td>
</tr>
<tr>
<td></td>
<td>Press twice to hear the phonetic character.</td>
</tr>
<tr>
<td>Read next character</td>
<td>VO-Shift-Right Arrow</td>
</tr>
<tr>
<td>Read previous character</td>
<td>VO-Shift-Left Arrow</td>
</tr>
<tr>
<td>Move to first visible word</td>
<td>VO-Home</td>
</tr>
<tr>
<td></td>
<td>On a portable computer, press VO-Fn-Left Arrow.</td>
</tr>
<tr>
<td>Move to last visible word</td>
<td>VO-End</td>
</tr>
<tr>
<td></td>
<td>On a portable computer, press VO-Fn-Right Arrow.</td>
</tr>
<tr>
<td>Move to beginning of text, scrolling if necessary</td>
<td>VO-Shift-Home</td>
</tr>
<tr>
<td></td>
<td>On a portable computer, press VO-Shift-Fn-Left Arrow.</td>
</tr>
<tr>
<td>Move to end of text, scrolling if necessary</td>
<td>VO-Shift-End</td>
</tr>
<tr>
<td></td>
<td>On a portable computer, press VO-Shift-Fn-Right Arrow.</td>
</tr>
<tr>
<td>Add new tab stop (in TextEdit only when the VoiceOver cursor is on a tab stop in the ruler)</td>
<td>VO-Space bar</td>
</tr>
<tr>
<td>Delete the current tab stop (in TextEdit only when the VoiceOver cursor is on a tab stop in the ruler)</td>
<td>VO-Delete</td>
</tr>
<tr>
<td>Interact with tab stop (in TextEdit only when the VoiceOver cursor is on a tab stop in the ruler)</td>
<td>VO-Shift-Down Arrow</td>
</tr>
<tr>
<td></td>
<td>Then use the Left and Right Arrow key to move the stop.</td>
</tr>
<tr>
<td>Reads the current word and character in the VoiceOver cursor</td>
<td>VO-F3</td>
</tr>
<tr>
<td>Reads the total number of lines and the number of visible lines in a document</td>
<td>VO-F3-F3</td>
</tr>
</tbody>
</table>
Web commands
Use these commands to navigate and interact with webpages.

NOTE: If your keyboard has an Fn key, press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next column</td>
<td>VO-Command-Y</td>
</tr>
<tr>
<td>Move to the previous column</td>
<td>VO-Command-Shift-Y</td>
</tr>
<tr>
<td>Move to the next frame</td>
<td>VO-Command-F</td>
</tr>
<tr>
<td>Move to the previous frame</td>
<td>VO-Command-Shift-F</td>
</tr>
<tr>
<td>Move to the next auto web spot</td>
<td>VO-Command-N</td>
</tr>
<tr>
<td>Move to the previous auto web spot</td>
<td>VO-Command-Shift-N</td>
</tr>
<tr>
<td>Move to the next web spot</td>
<td>VO-Command-{</td>
</tr>
<tr>
<td>Move to the previous web spot</td>
<td>VO-Command-[</td>
</tr>
<tr>
<td>Open the Web Item rotor</td>
<td>VO-U</td>
</tr>
<tr>
<td>Read from the current location on a webpage</td>
<td>VO-A</td>
</tr>
<tr>
<td>webpage to the end of the page</td>
<td></td>
</tr>
<tr>
<td>Read from the beginning of a webpage to the</td>
<td>VO-B</td>
</tr>
<tr>
<td>current location</td>
<td></td>
</tr>
<tr>
<td>Read a link address (URL)</td>
<td>VO-Shift-U</td>
</tr>
<tr>
<td>Read the next sentence</td>
<td>VO-Command-Page Down</td>
</tr>
<tr>
<td>Read the previous sentence</td>
<td>VO-Command-Page Up</td>
</tr>
<tr>
<td>Read webpage statistics</td>
<td>VO-Shift-I</td>
</tr>
<tr>
<td>Remove a web spot</td>
<td>VO-Command-Shift-{</td>
</tr>
<tr>
<td>Set a web spot</td>
<td>VO-Command-Shift-}</td>
</tr>
<tr>
<td>Set the sweet spot</td>
<td>VO-Command-Shift-}</td>
</tr>
<tr>
<td>Turn the grouping of items within a table</td>
<td>VO-=</td>
</tr>
<tr>
<td>on or off</td>
<td></td>
</tr>
</tbody>
</table>

VoiceOver standard gestures
If you’re using a Multi–Touch trackpad, you can use VoiceOver gestures. VoiceOver provides a set of standard gestures for navigating and interacting with items on the screen. You can’t modify this set of gestures.

NOTE: Gestures that don’t mention a specific number of fingers are single–finger gestures.

<table>
<thead>
<tr>
<th>Action</th>
<th>Gesture</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Enable the Trackpad Commander and VoiceOver gestures</td>
<td>VO-Two-finger rotate clockwise</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Disable the Trackpad Commander and VoiceOver gestures</td>
<td>VO-Two-finger rotate counterclockwise</td>
</tr>
<tr>
<td>Turn the screen curtain on or off</td>
<td>Three-finger triple-tap</td>
</tr>
<tr>
<td>Mute or unmute VoiceOver</td>
<td>Three-finger double-tap</td>
</tr>
</tbody>
</table>

### Navigation

| Force the VoiceOver cursor into a horizontal or vertical line when you drag a finger across the trackpad | Hold down the Shift key and drag a finger horizontally or vertically |
| Move the VoiceOver cursor to the next item | Flick right |
| Move the VoiceOver cursor to the previous item | Flick left |
| Move content or the scroll bar (depending on the Trackpad Commander setting) | Three-finger flick in any direction |
| Go to the Dock | Two-finger double-tap near the bottom of the trackpad |
| This gesture moves the VoiceOver cursor to the Dock wherever it's positioned on the screen | |
| Go to the menu bar | Two-finger double-tap near the top of the trackpad |
| Open the Application Chooser | Two-finger double-tap on the left side of the trackpad |
| Open the Window Chooser | Two-finger double-tap on the right side of the trackpad |
| Jump to another area of the current application | Press Control while touching a finger on the trackpad |

### Interaction

<p>| Speak the item in the VoiceOver cursor or, if there isn't an item, play a sound effect to indicate a blank area | Touch (includes tap or dragging) |
| Select an item | Double-tap anywhere on the trackpad |
| You can also split-tap (touch one finger and then tap with a second finger on the trackpad) |
| Start interacting with the item in the VoiceOver cursor | Two-finger flick right |
| Stop interacting with the item in the VoiceOver cursor | Two-finger flick left |
| Scroll one page up or down | Three-finger flick up or down |
| Escape (close a menu without making a selection) | Two-finger scrub back and forth |
| Increase or decrease the value of a slider, splitter, stepper, or other control | Flick up (increase) or flick down (decrease) |</p>
<table>
<thead>
<tr>
<th>Text</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read the current page, starting at the top</td>
<td>Two-finger flick up</td>
</tr>
<tr>
<td>Read from the VoiceOver cursor to the end of the current page</td>
<td>Two-finger flick down</td>
</tr>
<tr>
<td>Pause or resume speaking</td>
<td>Two-finger tap</td>
</tr>
<tr>
<td>Describe what's in the VoiceOver cursor</td>
<td>Three-finger tap</td>
</tr>
<tr>
<td>Change how VoiceOver reads text (by word, line, sentence, or paragraph)</td>
<td>Press the Command key while touching a finger on the trackpad</td>
</tr>
<tr>
<td><strong>Rotor</strong></td>
<td></td>
</tr>
<tr>
<td>Change the rotor settings</td>
<td>Two-finger rotate</td>
</tr>
<tr>
<td>Move to the previous item based on the rotor setting</td>
<td>Flick up</td>
</tr>
<tr>
<td>Move to the next item based on the rotor setting</td>
<td>Flick down</td>
</tr>
</tbody>
</table>

To customize other gestures by assigning VoiceOver commands to them, use the Trackpad Commander.

Refer to "Chapter 11. Using VoiceOver Gestures: Assigning VoiceOver commands to gestures."

If you need a reminder about what a gesture does, press VO-K to start keyboard help, and then use the gesture on the trackpad and listen to the description.

Refer to "Chapter 2. Learning VoiceOver Basics: Learning about keys, keyboard shortcuts, and gestures."

New and changed VoiceOver commands in Mac OS X 10.6
VoiceOver in Mac OS X introduces several new and changed commands.

**NOTE:** If your keyboard has an Fn key, press the Fn key when you press a function key.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Turn the Keyboard Commander on or off</td>
<td>VO-Shift-K</td>
</tr>
<tr>
<td>Speak the location of the insertion point</td>
<td>VO-F4-F4</td>
</tr>
<tr>
<td>Turn on or off the grouping of items within a table</td>
<td>VO-=</td>
</tr>
<tr>
<td>Action</td>
<td>Command</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Move the VoiceOver cursor to the next column (only when items within tables are not being grouped)</td>
<td>VO-Command-Y</td>
</tr>
<tr>
<td>Move the VoiceOver cursor to the previous column (only when items within tables are not being grouped)</td>
<td>VO-Command-Shift-Y</td>
</tr>
<tr>
<td>Next auto web spot</td>
<td>VO-Command-N</td>
</tr>
<tr>
<td>Previous auto web spot</td>
<td>VO-Command-Shift-N</td>
</tr>
<tr>
<td>Next web spot</td>
<td>VO-Command-]</td>
</tr>
<tr>
<td>Previous web spot</td>
<td>VO-Command-[</td>
</tr>
<tr>
<td>Delete web spot</td>
<td>VO-Command-Shift-}</td>
</tr>
<tr>
<td>Set web spot</td>
<td>VO-Command-Shift-)</td>
</tr>
<tr>
<td>Set sweet spot</td>
<td>VO-Command-Shift-)}</td>
</tr>
<tr>
<td>Next misspelled word</td>
<td>VO-Command-E</td>
</tr>
<tr>
<td>Previous misspelled word</td>
<td>VO-Command-Shift-E</td>
</tr>
<tr>
<td>Next sentence</td>
<td>VO-Command-Page Down</td>
</tr>
<tr>
<td>Previous sentence (in documents and webpages)</td>
<td>VO-Command-Page Up</td>
</tr>
<tr>
<td>Next page (documents only)</td>
<td>VO-Page Down</td>
</tr>
<tr>
<td>Previous page (documents only)</td>
<td>VO-Page Up</td>
</tr>
<tr>
<td>Size of item in VoiceOver cursor</td>
<td>VO-Command-F3</td>
</tr>
<tr>
<td>Position of item in VoiceOver cursor</td>
<td>VO-Command-F3-F3</td>
</tr>
<tr>
<td>Read webpage statistics</td>
<td>VO-Shift-I</td>
</tr>
<tr>
<td>Read an element's help tag</td>
<td>VO-Shift-H</td>
</tr>
<tr>
<td>Read an element's VoiceOver hint</td>
<td>VO-Shift-N</td>
</tr>
<tr>
<td>Open Web Item rotor</td>
<td>VO-U</td>
</tr>
<tr>
<td>Open Hot Spot Chooser</td>
<td>VO-[number key]-[number key]</td>
</tr>
<tr>
<td>Move a UI element</td>
<td>VO-Command-'</td>
</tr>
<tr>
<td>Open resize UI element menu</td>
<td>VO-Command---</td>
</tr>
<tr>
<td><strong>Changed</strong></td>
<td></td>
</tr>
<tr>
<td>Open VoiceOver Online Help</td>
<td>VO-?</td>
</tr>
<tr>
<td>Open Commands Help menu</td>
<td>VO-H-H</td>
</tr>
</tbody>
</table>

VoiceOver adds support for gestures when using a Multi-Touch trackpad. You can use standard VoiceOver gestures, which you can't change, and other gestures which you can customize by assigning VoiceOver commands to them.


**Appendix B. VoiceOver Utility Options**
This chapter lists the options on each VoiceOver Utility pane and explains how to use the options.
**General category**

Use the General category to specify a login greeting, use portable preferences, and enable AppleScript scripts to control VoiceOver.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Greeting</td>
<td>The text VoiceOver speaks when you log in while VoiceOver is on. To change the greeting, type new text over the default text.</td>
</tr>
<tr>
<td>Display welcome dialog when VoiceOver starts</td>
<td>Select the checkbox to display the dialog each time VoiceOver starts.</td>
</tr>
<tr>
<td>Portable Preferences</td>
<td>VoiceOver indicates whether it detects a portable preferences drive. Click one of these buttons:</td>
</tr>
<tr>
<td></td>
<td>Set Up: To create and use a portable preferences drive.</td>
</tr>
<tr>
<td></td>
<td>Stop: To stop using the detected portable preferences drive.</td>
</tr>
<tr>
<td></td>
<td>Start: To start using the detected portable preferences drive.</td>
</tr>
<tr>
<td>Allow VoiceOver to be controlled with AppleScript</td>
<td>Select the checkbox to be able to use AppleScript scripts to automate VoiceOver tasks.</td>
</tr>
</tbody>
</table>

**General pane of the Verbosity category**

Use the General pane of the Verbosity category to specify the default verbosity level (amount of information you want to hear) and a verbosity level for specific controls, such as applications, checkboxes, or Dock items.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Verbosity</td>
<td>From the pop-up menu, choose the default verbosity level for hearing about items on the screen.</td>
</tr>
</tbody>
</table>
You can change the default verbosity level while you’re working by using the verbosity rotor. To display the rotor, press VO-V.

**Text pane of the Verbosity category**

Use the Text pane of the Verbosity category to customize the amount of punctuation, text, and text attributes you hear, among other options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Punctuation</strong></td>
<td>From the pop-up menu, choose how much punctuation you want to hear:</td>
</tr>
<tr>
<td></td>
<td>All: Hear all special symbols and punctuation except for spaces. VoiceOver reads a sentence like this, “She turned and stopped comma then started walking again period”</td>
</tr>
<tr>
<td></td>
<td>Most: Hear all special symbols but not common punctuation, such as the comma and period.</td>
</tr>
<tr>
<td></td>
<td>Some: Hear keyboard symbols and many math symbols, such as + (plus) sign.</td>
</tr>
<tr>
<td></td>
<td>None: Hear text as you would normally read it, with pauses for commas and periods.</td>
</tr>
<tr>
<td><strong>Repeated Punctuation</strong></td>
<td>From the pop-up menu, choose how you want to hear repeated punctuation: always or a specific number of times.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>While typing speak</td>
<td>From the pop-up menu, choose what you want to hear while typing (called the &quot;typing echo&quot;): <strong>Characters, Words, Characters and Words, Nothing.</strong> Characters is the default setting. VoiceOver speaks a word when you enter a space after the last character or end a sentence with punctuation. It speaks a partially completed word if you pause while typing.</td>
</tr>
<tr>
<td>When moving the cursor</td>
<td>From the pop-up menu, choose how you want to hear text when moving the VoiceOver cursor: &quot;Speak text the cursor passes&quot; or &quot;Speak text to the right of the cursor.&quot;</td>
</tr>
<tr>
<td>When text attributes changes</td>
<td>From the pop-up menu, choose how you want to hear changes in text attributes: <strong>Do Nothing, Play Tone, Speak Attributes.</strong></td>
</tr>
<tr>
<td>When encountering a misspelled word</td>
<td>Choose how you want to hear misspelled words: <strong>Do Nothing: Hear the word.</strong> <strong>Play Tone: Hear a sound effect.</strong> <strong>Speak Attributes: Hear &quot;misspelled&quot; and then the word.</strong></td>
</tr>
<tr>
<td>When encountering a link</td>
<td>From the pop-up menu, choose how you want to hear links: <strong>Speak Link: Hear &quot;link&quot; and then the link text.</strong> <strong>Change Pitch: Hear the link text in a different voice pitch than unlinked text.</strong> <strong>Play Tone: Hear a sound effect.</strong> <strong>Do Nothing: Hear the link text.</strong></td>
</tr>
<tr>
<td>Read numbers as</td>
<td>From the pop-up menu, choose how you want to hear numbers: <strong>Words or Digits.</strong></td>
</tr>
</tbody>
</table>
When reading a capital letter

From the pop-up menu, choose how you want to hear uppercase letters or words that start with uppercase letters, depending on your settings for typing echo:

- Change Pitch: Hear the letter or word in a different voice pitch than lowercase text.
- Play Tone: Hear a sound effect.
- Speak Cap: Hear “cap” and then the letter or word.
- Do Nothing: Hear the letter or word.

When deleting text

From the pop-up menu, choose how you want to hear text that you’re deleting:

- Change Pitch: Hear the text you’re deleting in a different voice pitch than other text.
- Play Tone: Hear a sound effect.
- Speak: Hear “deleting” and then the text you’re deleting.
- Do Nothing: Hear the text you’re deleting.

Words are separated by

From the pop-up menu, choose how you want to hear word separations: “Punctuation and whitespace” or Whitespace.

Announcements pane of the Verbosity category

Use the Announcements pane of the Verbosity category to specify when you want VoiceOver to announce certain events, such as when a modifier key is pressed, and when to speak certain text, such as labels in dialogs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce when mouse cursor enters a window</td>
<td>Select the checkbox to hear when the mouse cursor goes to a window. This setting is useful if you’re using the mouse cursor independently of the VoiceOver cursor and keyboard focus.</td>
</tr>
<tr>
<td>Announce when a modifier key is pressed</td>
<td>Select the checkbox to hear when you press a modifier key. This setting is useful while you’re still learning VoiceOver commands and want to confirm the keys you’re pressing.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Announce when the Caps Lock key is pressed</td>
<td>Select the checkbox to hear when you press the key that makes all letters uppercase. This setting is useful for when you press the key inadvertently and are typing everything in uppercase.</td>
</tr>
<tr>
<td>Speak header when navigating across a table row</td>
<td>Select the checkbox to hear header text in a table row. This setting is useful for identifying the type of content in a row.</td>
</tr>
<tr>
<td>Automatically speak text in dialog boxes</td>
<td>Select the checkbox to hear labels and other text in dialogs.</td>
</tr>
<tr>
<td>When status text changes under VoiceOver cursor</td>
<td>Choose how you want to hear status text changes, such as software installation percentages, from the pop-up menu: Play Tone, Speak Text, Do Nothing.</td>
</tr>
<tr>
<td>When progress indicator changes under VoiceOver cursor</td>
<td>Choose how you want to hear progress indicator changes from the pop-up menu: Play Tone, Speak Update, Do Nothing.</td>
</tr>
<tr>
<td>Speak size and position in</td>
<td>Choose how you want to hear size and position from the pop-up menu: Inches, Millimeters, Pixels.</td>
</tr>
<tr>
<td>Speak text under mouse after delay</td>
<td>Drag the slider toward Short or Long to specify how many seconds you want VoiceOver to wait before it speaks the text that's under the mouse cursor.</td>
</tr>
</tbody>
</table>

**Hints pane of the Verbosity category**

Use the Hints pane to have VoiceOver provide more information about the item in the VoiceOver cursor.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speak instructions for using the item in the VoiceOver cursor</td>
<td>Select the checkbox to have VoiceOver automatically read instructions, if available, for the item.</td>
</tr>
<tr>
<td>When an item has a help tag</td>
<td>From the pop-up menu, choose how you want to hear the descriptions (called &quot;help tags&quot; or &quot;tooltips&quot;) that are displayed when the pointer rests briefly over an item: Do Nothing, Speak Notification, Speak Help Tag (the default setting).</td>
</tr>
<tr>
<td>Speak hints after delay</td>
<td>Drag the slider toward Short or Long to set how many seconds VoiceOver waits before it speaks the hint for the item under the mouse cursor.</td>
</tr>
</tbody>
</table>
## Voices pane of the Speech category
Use the Voices pane of the Speech category to mute speech and customize voice settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute Speech</td>
<td>Select the checkbox to turn off speech without affecting VoiceOver sound effects or the audio of other applications.</td>
</tr>
<tr>
<td>Voice</td>
<td>From the pop-up menu, choose a default voice for VoiceOver, such as Alex. To choose different voices for specific items, such as status or attributes, click the disclosure triangle.</td>
</tr>
<tr>
<td>Rate</td>
<td>Click the up or down arrow on the stepper to set the speed at which a voice speaks.</td>
</tr>
<tr>
<td>Pitch</td>
<td>Click the up or down arrow on the stepper to set how high or low a voice speaks.</td>
</tr>
<tr>
<td>Volume</td>
<td>Click the up or down arrow on the stepper to set how loudly or softly a voice speaks.</td>
</tr>
<tr>
<td>Intonation</td>
<td>Click the up or down arrow on the stepper to set how a voice rises and falls as it speaks.</td>
</tr>
</tbody>
</table>

## Pronunciation pane of the Speech category
Use the Pronunciation pane of the Speech category to customize pronunciation for words, acronyms, and symbols.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Text       | Indicates the text you want VoiceOver to pronounce in a certain way when it reads it.  
To change the current text, navigate to it and press VO-Space bar. |
| Substitution| Indicates how you want VoiceOver to pronounce the text.  
To change the current substitution, navigate to it and press VO-Space bar. |
| Application| Indicates the application where the substitution is used.  
To change the application, from the pop-up menu, choose a different application or all currently open applications (the default). The menu lists only applications that are currently open. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Case</td>
<td>Select the checkbox to ignore capitalization. If VoiceOver is set to indicate capitalization when speaking, you might want to ignore uppercase and lowercase in your pronunciations.</td>
</tr>
<tr>
<td>Add (+) button</td>
<td>Click the button to add a substitution to the list.</td>
</tr>
<tr>
<td>Remove (-) button</td>
<td>Click the button to remove the selected substitution from the list.</td>
</tr>
</tbody>
</table>

**Navigation category**

Use the Navigation category to customize navigation settings, such as those related to using the VoiceOver cursor and automatically interacting with items.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial position of VoiceOver cursor</td>
<td>From the pop-up menu, choose the initial position of the VoiceOver cursor in a new window: &quot;Keyboard focused item&quot; or &quot;First item in window.&quot;</td>
</tr>
<tr>
<td>Keyboard focus follows VoiceOver cursor</td>
<td>Select the checkbox to make the keyboard focus follow wherever the VoiceOver cursor goes whenever possible.</td>
</tr>
<tr>
<td>VoiceOver cursor follows keyboard focus</td>
<td>Select the checkbox to make the VoiceOver cursor follow wherever the keyboard focus goes. When this option and the previous option are selected, VoiceOver cursor tracking is on.</td>
</tr>
<tr>
<td>Insertion point follows VoiceOver cursor</td>
<td>Select the checkbox to make the insertion point follow wherever the VoiceOver cursor goes.</td>
</tr>
<tr>
<td>VoiceOver cursor follows insertion point</td>
<td>Select the checkbox to make the VoiceOver cursor follow wherever the insertion point goes.</td>
</tr>
<tr>
<td>Mouse cursor</td>
<td>From the pop-up menu, choose how you want the mouse cursor to follow the VoiceOver cursor: &quot;Ignores VoiceOver cursor,&quot; &quot;Follows VoiceOver cursor,&quot; &quot;Moves VoiceOver cursor.&quot; The default setting is &quot;Ignores VoiceOver cursor.&quot;</td>
</tr>
<tr>
<td>Allow cursor wrapping</td>
<td>Select the checkbox to wrap the VoiceOver cursor up, down, left, and right in a continuous loop when you're navigating.</td>
</tr>
<tr>
<td>Skip redundant labels</td>
<td>Select this checkbox to hear duplicate labels only once.</td>
</tr>
</tbody>
</table>
### Web category
Use the Web category to set options related to navigating and browsing webpages.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate webpages by</td>
<td>Choose a method for navigating webpages from the radio buttons:</td>
</tr>
<tr>
<td></td>
<td>DOM order: Move the VoiceOver cursor through a webpage based on the page's Document Object Model (DOM). Navigating by DOM moves left and right, in the order the webpage's author intended. (Moving up and down in DOM mode is based on the current setting of the Web Item rotor).</td>
</tr>
<tr>
<td></td>
<td>Grouping items: Move the VoiceOver cursor from one group of information to the next, such as from one paragraph to the next paragraph. Navigating by group moves in any direction, to help give you a sense of context.</td>
</tr>
<tr>
<td>Speak webpage summary</td>
<td>Select the checkbox to have VoiceOver speak a summary (statistics) of the items on a webpage when the page opens. The summary is based on the items included in the Web Item rotor.</td>
</tr>
<tr>
<td></td>
<td>For example, if the rotor includes headers, links, auto web spots, and form controls, the webpage summary that VoiceOver speaks might sound like &quot;The Apple – Accessibility page has 14 headers 52 links 8 auto web spots 1 form control.&quot;</td>
</tr>
<tr>
<td>Move the VoiceOver cursor to it</td>
<td>Select the checkbox to position the VoiceOver cursor on the first item or the sweet spot (if one exists) when a webpage opens.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Automatically speak the webpage</td>
<td>Select the checkbox to have VoiceOver start speaking a webpage when the page opens. If you set a sweet spot on the page, VoiceOver starts reading from the sweet spot; otherwise, it starts reading from the beginning of the page.</td>
</tr>
<tr>
<td></td>
<td>This option is available only if you've selected the previous option to move the VoiceOver cursor to the first link.</td>
</tr>
<tr>
<td>Group items within</td>
<td>Select the checkbox to hear a summary of a table and a summary of each cell as you navigate the table using the arrow keys. This option is useful if you're familiar with a table and don't need to read its contents. If you do want to read the contents of a cell, you must interact with it using VoiceOver commands.</td>
</tr>
<tr>
<td></td>
<td>When the checkbox isn't selected, you automatically interact with a table and read its contents, cell by cell, as you navigate the table using the arrow keys.</td>
</tr>
<tr>
<td>Speak column and row numbers</td>
<td>Select the checkbox to have VoiceOver speak the column and row numbers in tables to help you navigate complex tables more easily. This option is on by default.</td>
</tr>
<tr>
<td>Navigate images</td>
<td>Choose how you want VoiceOver to navigate images from the pop-up menu: Never, With Descriptions, Always. By default, VoiceOver navigates only to images that contain a description, called &quot;alt text.&quot; This option is useful because many websites use images for links.</td>
</tr>
<tr>
<td>Web Item Rotor includes</td>
<td>From the pop-up menu, choose the items (such as headers, frames, or tables) to include in the Web Item rotor. By default, all of the items are included.</td>
</tr>
</tbody>
</table>

**Sound category**

Use the Sound category to set options related to sound effects and positional audio.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute sound effects</td>
<td>Select the checkbox to turn off sound effects without affecting VoiceOver speech or the audio of other applications.</td>
</tr>
</tbody>
</table>
Enable positional audio

Select the checkbox to add audio cues that help you locate items on the screen. The cues play in stereo; you need a pair of earbuds or stereo headphones, or standard stereo speakers, to hear them. Positional audio is on by default.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show VoiceOver cursor</td>
<td>Select the checkbox to show the VoiceOver cursor (the default setting). The VoiceOver cursor appears as a dark outlined box.</td>
</tr>
<tr>
<td>VoiceOver Cursor Magnification</td>
<td>Drag the slider toward Small or Large to decrease or increase the size of the VoiceOver cursor.</td>
</tr>
<tr>
<td>When reading text, move VoiceOver cursor by</td>
<td>From the pop-up menu, choose how the VoiceOver cursor should move while reading: Sentence, Word.</td>
</tr>
</tbody>
</table>

**Caption Panel pane of the Visuals category**

Use the Caption Panel pane of the Visuals category to customize the size and appearance of the caption panel.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show caption panel</td>
<td>Select the checkbox to display the caption panel.</td>
</tr>
<tr>
<td>Caption Panel Font Size</td>
<td>Drag the slider toward Small or Large to set the font size in the caption panel.</td>
</tr>
<tr>
<td>Rows in Caption Panel</td>
<td>Drag the slider toward 1 or 10 to remove or add rows, changing the height of the panel.</td>
</tr>
<tr>
<td>Caption Panel Transparency</td>
<td>Drag the slider toward 0 percent or 100 percent to decrease or increase the panel's transparency. If you increase the transparency, the panel's background color becomes lighter and you can more easily see the screen behind the panel.</td>
</tr>
</tbody>
</table>
Braille Panel pane of the Visuals category
Use the Braille Panel pane of the Visuals category to customize the appearance of the braille panel.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Braille Panel</td>
<td>From the pop–up menu, choose how you want to display the braille panel: Off, On, Automatic. When set to the default setting Automatic, the braille panel is displayed when you connect a refreshable braille display to your computer.</td>
</tr>
<tr>
<td>Braille Font Color</td>
<td>From the pop–up menu, choose a color for displaying text in the braille panel.</td>
</tr>
<tr>
<td>Braille Panel Font Size</td>
<td>Drag the slider toward Small or Large to set the font size in the braille panel.</td>
</tr>
<tr>
<td>Braille Panel Transparency</td>
<td>Drag the slider toward 0 percent or 100 percent to decrease or increase the panel's transparency. If you increase the transparency, the panel's background color becomes lighter and you can more easily see the screen behind the panel.</td>
</tr>
</tbody>
</table>

Touch pane of the Visuals category
Use the Touch pane of the Visuals category to customize the transparency of the background that dims the screen around the focus area.

This pane is only visible when you're using a Multi-Touch trackpad.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Transparency</td>
<td>Drag the slider toward 0 percent or 100 percent to decrease or increase the transparency of the dimmed background around the focus area. If you increase the transparency, the background color becomes lighter and you can more easily see the rest of the screen.</td>
</tr>
</tbody>
</table>

Menus pane of the Visuals category
Use the Menus pane of the Visuals category to customize the appearance of VoiceOver menus, such as the Commands menu or Web Item menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VoiceOver Menus Font Size</td>
<td>Drag the slider toward Small or Large to set the font size used in VoiceOver menus.</td>
</tr>
<tr>
<td>VoiceOver Menus Transparency</td>
<td>Drag the slider toward 0 percent or 100 percent to decrease or increase the transparency of the menus. If you increase the transparency, a menu’s background color becomes lighter and you can more easily see the screen behind the menu.</td>
</tr>
</tbody>
</table>

**NumPad pane of the Commanders category**
Use the NumPad pane of the Commanders category to enable the NumPad Commander and assign VoiceOver commands to numeric keypad keys.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable NumPad Commander</td>
<td>Select the checkbox to enable the NumPad Commander. When the NumPad Commander is enabled, you can't use Mouse Keys, a Universal Access feature in Mac OS X.</td>
</tr>
<tr>
<td>Modifier pop-up menu</td>
<td>From the pop-up menu, choose a modifier key to increase the number of numeric keys you can assign VoiceOver commands to.</td>
</tr>
<tr>
<td>Numpad Key</td>
<td>Indicates the numeric keypad key you've assigned a VoiceOver command to.</td>
</tr>
<tr>
<td>Command</td>
<td>Indicates the VoiceOver command currently assigned to a numeric keypad key. Click the current command to display pop-up menus for the different types of commands you can assign to a key.</td>
</tr>
</tbody>
</table>

**Keyboard pane of Commanders category**
Use the Keyboard pane to enable the Keyboard Commander and assign VoiceOver commands to key combinations that might be easier for you to remember or perform.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Keyboard Commander</td>
<td>Select the checkbox to enable the Keyboard Commander so you can assign VoiceOver commands to keyboard keys.</td>
</tr>
<tr>
<td>Use Left Option Key or Right Option key</td>
<td>Click the checkbox to use either the left or right Option key as the designated Keyboard Commander modifier.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Enable Keyboard Commander | Select the checkbox to enable the Keyboard Commander so you can assign VoiceOver commands to keyboard keys.
Use Left Option Key or Right Option key | Click the checkbox to use either the left or right Option key as the designated Keyboard Commander modifier.
Keyboard Key | Double click a key and type a new key to assign to the VoiceOver command that's displayed.
Command | From the pop-up menus, choose a different command to assign to the key that's displayed.
Add (+) button | Click the button to add a key to the list. Then from the pop-up menus, type the key and choose a VoiceOver command to assign to it.
Remove (-) button | Click the button to delete a key from the list.

**Trackpad pane of Commanders category**

Use the Trackpad pane to enable the Trackpad Commander and set other options for using VoiceOver gestures.

This pane is available only when VoiceOver detects a Multi-Touch trackpad.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Trackpad Commander</td>
<td>Select the checkbox to use standard Voiceover gestures and assign VoiceOver commands to other gestures.</td>
</tr>
<tr>
<td>Automatically select items in lists and tables</td>
<td>Select the checkbox to have VoiceOver automatically select the list or table item you're touching when you lift your finger from the trackpad.</td>
</tr>
</tbody>
</table>
If you don't want VoiceOver to select an item, drag your finger off the list or table before lifting your finger. |
| Pause speech when not touching the trackpad | Select this checkbox to have VoiceOver pause speech when you lift your finger off the trackpad while dragging. For example, if you're dragging a finger on the trackpad to navigate lines of text and you lift your finger, VoiceOver pauses speech. |
| Scroll gesture moves content instead of scroll bar | Select this checkbox to scroll the content (not the scroll bar) down or up. Normally when you move the scroll bar down or up, the content moves in the opposite direction. When this option is selected, the content moves in the same direction you're scrolling. |
Assign Commands | Click the button to display the pane in which you assign VoiceOver commands to gestures.

---

**Trackpad Commander assignments pane**
Use the Trackpad Commander assignments pane to assign VoiceOver commands to trackpad gestures.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifier pop-up menu</td>
<td>From the pop-up menu, choose the modifier key you want to use with gestures. By default, Command is used.</td>
</tr>
<tr>
<td>Trackpad Gesture</td>
<td>Indicates the gestures you can assign VoiceOver commands to.</td>
</tr>
<tr>
<td>Command</td>
<td>Click the command field to display pop-up menus for the different types of commands you can assign to a gesture.</td>
</tr>
</tbody>
</table>

**Layout pane of the Braille category**
Use the Layout pane of the Braille category to customize settings for using a braille display connected to or paired with your computer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Braille Display</td>
<td>VoiceOver indicates the braille display it detects.</td>
</tr>
<tr>
<td>Braille Translation</td>
<td>Choose a translation to use for showing output from the pop-up menu.</td>
</tr>
<tr>
<td>Show Contracted Braille</td>
<td>Select the checkbox to show output in contracted braille. The default setting is uncontracted braille. When using contracted braille, VoiceOver automatically uncontracts the word in the VoiceOver cursor so you can edit it more precisely, and then contracts the word when the VoiceOver cursor leaves it.</td>
</tr>
<tr>
<td>Use dots 7 and 8 to indicate cursor</td>
<td>Select the checkbox to raise dots 7 and 8 to indicate the position of the VoiceOver cursor. This option is selected by default.</td>
</tr>
</tbody>
</table>
| Status cells | Select checkboxes for the status cells you want to use.  
|             | Show general display status: Show information about the direction in which to pan the current line and about announcements.  
|             | Show text style: Show common text styles, such as bold or italic font.  
|             | Show extended text style: Show less common text styles, such as strikethrough or superscript.  
| Show status on the | Select a radio button to use cells to the left or right of the braille line as the status cells.  
|               | Use this setting only if your braille display does not provide dedicated status cells.  |

**Displays pane of the Braille category**

Use the Displays pane to view a list of the refreshable braille displays connected to or paired with your computer, and to assign VoiceOver commands to keys on the braille displays.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display list            | VoiceOver lists the braille displays it has detected.  
|                         | The list indicates the primary device and disconnected devices, as well as devices physically connected to your computer (USB symbol) and Bluetooth devices paired with your computer (Bluetooth symbol). |
| Display information     | VoiceOver shows information about the display selected in the list, such as the number of cells and status cells.  
| Assign Commands         | Click the button to assign VoiceOver commands to keys on your braille display.  
| Primary braille display | Select the checkbox to use the selected braille display as the primary display for mirroring.  
| Add (+) and Remove (-) buttons | Click Add to set up a Bluetooth braille display to use with VoiceOver, or click Remove to delete a Bluetooth braille display from the list. You can use one Bluetooth braille display at a time. |
Option | Description
--- | ---
**Display list** | VoiceOver lists the braille displays it has detected. The list indicates the primary device and disconnected devices, as well as devices physically connected to your computer (USB symbol) and Bluetooth devices paired with your computer (Bluetooth symbol).

**Display information** | VoiceOver shows information about the display selected in the list, such as the number of cells and status cells.

**Assign Commands** | Click the button to assign VoiceOver commands to keys on your braille display.

**Primary braille display** | Select the checkbox to use the selected braille display as the primary display for mirroring.

**Add (+) and Remove (-) buttons** | Click Add to set up a Bluetooth braille display to use with VoiceOver, or click Remove to delete a Bluetooth braille display from the list. You can use one Bluetooth braille display at a time.

**Only allow input from primary braille display when mirroring** | Select the checkbox to accept input only from the primary display, and prevent input from each braille display that's connected to your computer.

For example, if you're in a classroom setting where students' braille displays are connected to the computer, you can prevent accidental input from those displays, limiting input only to the instructor's display.

For some Bluetooth braille displays, after you turn off the braille display and move it out of range of your computer, wait for 30 seconds or longer to ensure your computer indicates the braille display is no longer connected. A Mac computer tries to maintain the connection during this interval in case the braille display was accidentally turned off or moved out of range.

When you turn on a paired Bluetooth braille display and move it in range of your computer, your computer should detect it in about five seconds.

---

**Copyright Notice**

© 2009 Apple Inc. All rights reserved.

Apple, the Apple logo, Cover Flow, Finder, iCal, iChat, iPhoto, iTunes, Mac, Macintosh, Mac OS, Multi-Touch, Safari, Snow Leopard, and Spotlight are trademarks of Apple Inc., registered in the U.S. and other countries.

019–1667

9/2009